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r a Class B digital device, pursuant
sonable protection against harmful
es and can radiate radio frequency
s, may cause harmful interference
ence will not occur in a particular
 or television reception, which can
ed to try to correct the interference

ich the receiver is connected.
for help.

autioned that changes or modifica-
ove standards could void your au-
FCC Statement
(Federal Communications Commission)
This equipment has been tested and found to comply with the limits fo
to Part 15 of the FCC Rules. These limits are designed to provide rea
interference in a residential installation. This equipment generates, us
energy and, if not installed and used in accordance with the instruction
to radio communications. However, there is no guarantee that interfer
installation. If this equipment does cause harmful interference to radio
be determined by turning the equipment off and on, the user is encourag
by one or more of the following measures:

• Re orient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to wh
• Consult the service representative or an experienced radio/TV technician 

Warning
Use only shielded cables to connect I/O devices to this equipment. You are c
tions not expressly approved by the manufacturer for compliance with the ab
thority to operate the equipment.
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TIONS
 the risk of fire, electric shock, and

h bowl, kitchen sink or laundry tub, 

ss type) during an electrical storm. 

k.
t dispose of batteries in a fire. They 

structions.
utput 20V, 9A minimum).

icing or disassembling this equip-

. 26 AWG OR LARGER, 
ORD
IMPORTANT SAFETY INSTRUC
Follow basic safety precautions, including those listed below, to reduce
injury to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, was
in a wet basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordle
There may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the lea
4. Use only the power cord and batteries indicated in this manual. Do no

may explode. Check with local codes for possible special disposal in
5. This product is intended to be supplied by a Listed Power Unit (DC O

CAUTION
Always disconnect all telephone lines from the wall outlet before serv
ment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO
TELECOMMUNICATION LINE C
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vent this, follow these suggestions:

 and the components could be dam-

pply away from any kind of heating 
ts into it, the computer could be 

ot place anything heavy 
e computer.

 com-
ironment.

Do not place the computer on 
any surface that will block the 
vents.
Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To pre

1. Don’t drop it, or expose it to shock. If the computer falls, the case
aged.

2. Keep it dry, and don’t overheat it. Keep the computer and power su
element. This is an electrical appliance. If water or any other liquid ge
badly damaged.

Do not expose the computer 
to any shock or vibration.

Do not place it on an unstable 
surface.

Do n
on th

Do not expose it to excessive 
heat or direct sunlight.

Do not leave it in a place 
where foreign matter or mois-
ture may affect the system.

Don’t use or store the
puter in a humid env
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sformers, electric motors, and other 
mage your data.

 computer down properly and don’t 
s data may be lost if the battery is 

he com- Perform routine maintenance 
on your computer.

rd before 
 devices.
3. Avoid interference. Keep the computer away from high capacity tran
strong magnetic fields. These can hinder proper performance and da

4. Follow the proper working procedures for the computer. Shut the
forget to save your work. Remember to periodically save your data a
depleted.

5. Take care when using peripheral devices.

Do not turn off the power 
until you properly shut down 
all programs.

Do not turn off any peripheral 
devices when the computer is 
on.

Do not disassemble t
puter by yourself.

Use only approved brands of 
peripherals.

Unplug the power co
attaching peripheral
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ith this computer.
tional travel but it still requires a 

e unsure of your local power specifi-
r local power company.
 or a 3-prong grounded plug. The 

 not defeat its purpose. If you do not 
alified electrician install one.
sure to disconnect it by the plug head, 

(s) you use can support the total cur-

 disconnected from any external 
r).

r cord if Do not place heavy objects 
on the power cord.
I

Power Safety
The computer has specific power requirements:

• Only use a power adapter approved for use w
• Your AC adapter may be designed for interna

steady, uninterrupted power supply. If you ar
cations, consult your service representative o

• The power adapter may have either a 2-prong
third prong is an important safety feature; do
have access to a compatible outlet, have a qu

• When you want to unplug the power cord, be 
not by its wire.

• Make sure the socket and any extension cord
rent load of all the connected devices.

• Before cleaning the computer, make sure it is
power supplies (i.e. AC adapter or car adapte

Do not plug in the power 
cord if you are wet.

Do not use the powe
it is broken.

Power Safety 
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines). It is
advisable to also re-
move your battery in
order to prevent acci-
dentally turning the
machine on.
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y explode, leak or damage the com-

maged (e.g. bent or twisted) in any 
lace, it may cause circuit damage, 

may make the battery explode.
ement to your service representative 

ways dispose of batteries carefully. 
 discarded.

attery is recyclable. At the end of its
his battery into the municipal waste
ecycling options or proper disposal.

e or equivalent type recommended
structions.
Battery Precautions
• Only use batteries designed for this computer. The wrong battery type ma

puter.
• Do not continue to use a battery that has been dropped, or that appears da

way. Even if the computer continues to work with a damaged battery in p
which may possibly result in fire.

• Recharge the batteries using the notebook’s system. Incorrect recharging 
• Do not try to repair a battery pack. Refer any battery pack repair or replac

or qualified service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Al

Batteries may explode or leak if exposed to fire, or improperly handled or
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.

Battery Disposal & Caution
The product that you have purchased contains a rechargeable battery. The b
useful life, under various state and local laws, it may be illegal to dispose of t
stream. Check with your local solid waste officials for details in your area for r

Danger of explosion if battery is incorrectly replaced. Replace only with the sam
by the manufacturer. Discard used battery according to the manufacturer’s in
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part of the computer.

 your warranty and expose you and
e personnel. Unplug the computer
nel under any of the following con-

structions.
s liquid if the LCD panel breaks).

, remember to replace the cover(s)
III

Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth. 
Do not use volatile (petroleum distillates) or abrasive cleaners on any 

Servicing
Do not attempt to service the computer yourself. Doing so may violate
the computer to electric shock. Refer all servicing to authorized servic
from the power supply. Then refer servicing to qualified service person
ditions:

• When the power cord or AC/DC adapter is damaged or frayed.
• If the computer has been exposed to rain or other liquids.
• If the computer does not work normally when you follow the operating in
• If the computer has been dropped or damaged (do not touch the poisonou
• If there is an unusual odor, heat or smoke coming from your computer.

Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade
and screw(s) before turning the computer on.
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stem is ready to go:

g. 
ed a second voltage adapter. How-
ters.
s.
a), pack them and those devices’ 

 or require proof of ownership for 

 travel bag (or any such container).
/fan intakes to be blocked. To pre-
intake while the computer is in use.
Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the sy

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC adapter and cables. Stow them in the carrying ba
5. The AC adapter uses voltages from 100 to 240 volts so you won’t ne

ever, check with your travel agent to see if you need any socket adap
6. Put the notebook in its carrying bag and secure it with the bag’s strap
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camer

adapters and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions

both hardware and software. Make sure your “papers” are handy.

Power Off Before Traveling
Make sure that your notebook is completely powered off before putting it into a
Putting a notebook which is powered on in a travel bag may cause the vents
vent your computer from overheating make sure nothing blocks the vent/fan 
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face, and Chapter 8: Troubleshoot-

t. In some areas, computer theft is
rs may not be sufficiently careful.

& X-ray machines can damage the
estroy any stored data - Pass your
inspect them (you may be asked to

rs and other electronic devices in
 the notebook in an overhead com-
n the compartment is opened.

he AC adapter and keep your bat-

ater vapor can condense inside the
e can evaporate.
On the Road
In addition to the general safety and maintenance suggestions in this pre
ing, keep these points in mind:

Hand-carry the notebook - For security, don’t let it out of your sigh
very common. Don’t check it with “normal” luggage. Baggage handle
Avoid knocking the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors 
computer, hard disk, floppy disks, and other media. They may also d
computer and disks around the devices. Ask security officials to hand-
turn it on). Note: Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of compute
flight. These restrictions are for your safety, follow them. If you stow
partment, make sure it’s secure. Contents may shift and/or fall out whe

Get power where you can - If an electrical outlet is available, use t
tery(ies) charged.

Keep it dry - If you move quickly from a cold to a warm location, w
computer. Wait a few minutes before turning it on so that any moistur
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t of the computer for long periods
jury from repetitive strain to your
 strain:

htly 
 relaxed 

n the 

bly.
gree 

e.

time. Fre-
Developing Good Work Habits
Developing good work habits is important if you need to work in fron
of time. Improper work habits can result in discomfort or serious in
hands, wrists or other joints. The following are some tips to reduce the

• Adjust the height of the chair and/or desk so that the keyboard is at or slig
below the level of your elbow. Keep your forearms, wrists, and hands in a
position.

• Your knees should be slightly higher than your hips. Place your feet flat o
floor or on a footrest if necessary.

• Use a chair with a back and adjust it to support your lower back comforta
• Sit straight so that your knees, hips and elbows form approximately 90-de

angles when you are working.
• Take periodic breaks if you are using the computer for long periods of tim

Remember to:
• Alter your posture frequently.
• Stretch and exercise your body several times a day.
• Take periodic breaks when you work at the computer for long periods of 

quent and short breaks are better than fewer and longer breaks.
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 strain and muscle fatigue in your

r outside sources of light.
 that allow you to see the screen 

nce.
II

Lighting
Proper lighting and comfortable display viewing angle can reduce eye
neck and shoulders.

• Position the display to avoid glare or reflections from overhead lighting o
• Keep the display screen clean and set the brightness and contrast to levels

clearly.
• Position the display directly in front of you at a comfortable viewing dista
• Adjust the display-viewing angle to find the best position.
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Overview 1 - 1

Quick Start Guide 1

C
O
T r computer, to navigating around the
co  covers the following:

• r e.g. the storage devices (hard disk, 
ail Program, Touch Pad, Mouse & 

•
•
• ration or improvement of some of the 

• ic Input Output System).
•
• nd PC Camera modules (some of 

ation).
•
• mputer communicate with external 

•
•

hapter 1: Quick Start Guide
verview

his Quick Start Guide is a brief introduction to the basic features of you
mputer and to getting your system started. The remainder of the manual

Chapter 2 A guide to using the some of the main features of the compute
optical device, 4-in-1 card reader, PC Card), Hot Keys, M
Printer.

Chapter 3 The video and audio features of the computer.
Chapter 4 The computer’s power saving options.
Chapter 5 The installation of the drivers and utilities essential to the ope

computer’s subsystems.
Chapter 6 An outline of the computer’s built-in software. or BIOS (Bas
Chapter 7 Instructions for upgrading your computer.
Chapter 8 A quick guide to the computer’s Wireless LAN, Bluetooth, a

which may be optional depending on your purchase configur
Chapter 9 A troubleshooting guide.
Appendix A Definitions of the interface, ports/jacks which allow your co

devices.
Appendix B The computer’s advanced power features.
Appendix C The computer’s specification.
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A
If ide. However you may find it useful
to and “Upgrading The Computer” on
p  a  of interest to you.

sers
 advanced knowledge of them) then
t Guide should be enough to get you
look through all the documentation
tup and system controls are covered
 not worry if you do not understand
rby and refer to it to learn as you go.
ked with a  as indicated in the mar-
he interface ports and jacks see “In-

W
N  safety information indicated by the

ted in the Preface.

N
O d applications (e.g. word processing,
sp sult the appropriate manuals.
 - 2 Overview

Quick Start Guide

dvanced Users
 you are an advanced user you may skip over most of this Quick Start Gu
 refer to “What to Install” on page 5 - 1, “BIOS Utilities” on page 6 - 1 

age 7 - 1 in the User’s Manual. You may also find the notes marked with

Beginners and Not-So-Advanced U
If you are new to computers (or do not have an
the information contained in the this Quick Star
up and running. Eventually you should try to 
(more detailed descriptions of the functions, se
in the remainder of the User’s Manual), but do
everything the first time. Keep this manual nea
You may find it useful to refer to the notes mar
gin. For a more detailed description of any of t
terface (Ports & Jacks)” on page  A - 1.

arning Boxes
o matter what your level please pay careful attention to the warning and
 symbol. Also please note the safety and handling instructions as indica

ot Included
perating Systems (e.g. Windows 2000 Professional, Windows XP etc.) an
readsheet and database programs) have their own manuals, so please con

Notes

Check the light colored
boxes with the mark
above to find detailed
information about the
computer’s features. 
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Quick Start Guide 1
S
Y ere this is not the case, or where you
ar  manual refers to the following oper-
at

•
•

different system, you will need to install
h act as an interface between the com-
t that you install the drivers in the order
ols until the necessary drivers and util-
rvice representative may have already
tructions.
ystem Software
our computer may already come with system software pre-installed. Wh
e re-configuring your computer for a different system, you will find this
ing systems:

Microsoft Windows 2000
Microsoft Windows XP (Home & Professional Editions)

Drivers

If you are installing new system software, or are re-configuring your computer for a 
the drivers listed in “Drivers & Utilities” on page 5 - 1. Drivers are programs whic
puter and a hardware component e.g. a wireless network module. It is very importan
listed in Table 5 - 1, on page 5 - 6. You will be unable to use most advanced contr
ities are properly installed. If your system hasn’t been properly configured (your se
done that for you), refer to “What to Install” on page 5 - 1 for installation ins
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S

 materials.
 on a stable surface.
 peripherals you want to use with the           
oard and mouse) to their ports.
ter to the DC-In jack at the rear of the 
 the AC power cord into an outlet, and 
er cord to the AC adapter.

es  in the direction of the arrows to     
er (hold the left latch in position).
o a comfortable viewing angle, and 
tton to turn the computer “on”.
el to a comfortable viewing angle.
  show the power and battery status 
d give notification of e-mail received.

th LCD Closed

1

2

t Down/Turn Off Computer command
ms.
 - 4 Overview

Quick Start Guide

ystem Startup
1. Remove all packing
2. Place the computer
3. Securely attach any

notebook (e.g. keyb
4. Attach the AC adap

computer, then plug
connect the AC pow

5. Move the LCD latch
release the top cov

6. Raise the lid/LCD t
press the power bu

7. Adjust the LCD pan
8. The LED indicators

of the computer, an

Figure 1 - 1 - AC Adapter Plugged-In & Top Panel wi

Shutdown

Please note that you should always shut your computer down by choosing the Shu
from the Start menu in Windows. This will help prevent hard disk or system proble

2

1 1

1. LCD Latches
2. LED Power & 

Communication 
Indicators
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Quick Start Guide 1
S en

pen

1. Optional Built-In PC 
Camera

2. LCD
3. LED Power & 

Communication 
Indicators

4. LED Status Indicators
5. Quick-Key Buttons
6. Power Button
7. Keyboard
8. TouchPad and Buttons
9. Speaker

3

4

5 6
System Map: Top Vi

ystem Map: Top View with LCD Panel Op

Figure 1 - 2 - Top View with LCD Panel O

2

5
3

1

7

8

4

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission
devices aboard aircraft is
usually prohibited. Make
sure the module(s) are
OFF if you are using the
computer aboard aircraft.
 
If you restart/shut down
the computer the power
status of the module will
remain the same as it
was before the restart/
shut down.

6

9
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- 2 - LED Status Indicators

or Description

en Number Lock Activated

en Caps Lock Activated

en Scroll Lock Activated (to activate 
press Fn & ScrLk)

en Hard Disk Activity

en The Optional WLAN Module is 
Powered On

en The Optional PC Camera 
Module is Powered On

en The Optional Bluetooth Module 
is Powered On
Quick Start Guide

 - 6 System Map: Top View with LCD Panel Open

ED Indicators
he two sets of LED indicators (LED Power & Com-
unication Indicators and LED Status Indicators)

n the computer display helpful information about the
rrent status of the computer.

able 1 - 1 - LED Power & Communication Indicators

Table 1 

Icon Color Description

Orange DC Power is Plugged In

Green The Computer is On

Blinking Green The Computer is in Standby 
Mode

Orange The Battery is Charging

Green The Battery is Fully Charged

Blinking Orange The Battery Has Reached 
Critically Low Power Status

Blinking Green New Mail Has Arrived

Icon Col

Gre

Gre

Gre

Gre

Gre

Gre

Gre
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 an embedded numerical keypad for
 input (see Figure 1 - 3) and features

 allow you to change operational fea-

gure 1 - 3 - Keyboard

ys
Num Lk & 
Scr Lk Keys

Numeric Keypad

Other Keyboards

 is damaged or you just want to make
can use any standard USB keyboard.
ll detect and enable it automatically.
l functions/hot keys unique to the sys-

eyboard may not work.
System Map: Top Vi

uick-Key Buttons
hese Quick-Keys give instant access to the default
ternet browser and e-mail program, and toggle pow-
 to the optional module(s) (WLAN/Bluetooth/PC
amera). Make sure you install the driver to enable the
uick-Key functions (refer to “What to Install” on
age 5 - 1).

Table 1 - 3 - Quick-Key Buttons

Keyboard
The keyboard has
easy numeric data
Function Keys to
tures instantly.

Fi

Quick-Key Function

 Activate the Default E-Mail Program

Activate the Default Internet Browser

Toggle Power to the Wireless LAN Module

Toggle Power to the Optional PC Camera 
Module

Toggle Power to the Optional Bluetooth 
Module

Fn Key

Function Ke

If your keyboard
a change, you 
The system wi
However specia
tem’s regular k
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1
F
T  appropriate function key (Esc - F10
et g the Hot Key driver (see“Hot Key
(W

Function

Display Toggle

ecrease LCD Brightness

Increase LCD Brightness

Number Lock Toggle

Scroll Lock Toggle

pecial characters. These special char-
(in the upper row of the keyboard) will
 - 8 System Map: Top View with LCD Panel Open

Quick Start Guide

unction Keys & Hot Keys
o use the function/ Hot Keys, press and hold the Fn key, then press the
c.). Additional Hot Keys/enhanced functions are available after installin

in2000/WinXP)” on page 5 - 11 &“Hot Keys” on page 2 - 8).

Table 1 - 4 - Function & Hot Keys

Key Function Key

Fn Function Key Fn + F7

Fn + Esc Sleep Toggle Fn + F8 D

Fn + F1 Hot Key Help Fn + F9

Fn + F3 Mute Toggle Fn + NumLk

Fn + F5 Decrease Audio Volume Fn + ScrLk

Fn + F6 Increase Audio Volume

Special Characters

Some software applications allow the number-keys to be used with Alt to produce s
acters can only be produced by using the numeric keypad. Regular number keys 
not work. Make sure that Num Lk is on.



Map: Front & Rear Views 1 - 9

Quick Start Guide 1
S

Figure 1 - 4
Front & Rear Views

1. LCD Latches
2. Speaker
3. Built-In Microphone
4. S/PDIF-Out Jack
5. Microphone-In Jack
6. Headphone-Out 

Jack
7. Line-In Jack
8. Vent/Fan Intake
9. DC-In Jack
10. Security Lock Slot
11. Parallel Port
12. 2 * USB 2.0 Ports
System 

ystem Map: Front & Rear Views
1

2
1

5 6 7

8

4

10 11
12

3

9

Overheating

To prevent your computer
from overheating make
sure nothing blocks the
vent/fan intake while the
computer is in use.
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5
4

5

SELF POW-
 - 10 System Map: Left View
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ystem Map: Left View
Figure 1 - 5
Left View

1. RJ-45 LAN Jack
2. S-Video-Out Jack
3. External Monitor (VGA) 

Port
4. Mini-IEEE 1394a Port
5. 2 * USB 2.0 Ports

3
1 2

IEEE 1394

The Mini-IEEE 1394 port only supports 
ERED IEEE 1394 devices.
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Figure 1 - 6 - Right View
1. Optical Device Drive Bay 

(for CD/DVD Device - see page 
2 - 3)

2. PC Card Slot (see page 2 - 7)
3. 4-in-1 Card Reader (reads SD/ 

MMC/ MS & MS Pro formats - 
see page 2 - 6)

4. Security Lock Slot

mergency Eject

 eject a CD/DVD (e.g. due to an unex-
n) you may push the end of a straight-

e emergency eject hole. Do not use a
ilar object that may break and become

edia Warning

oppy disk/CD/DVD while the system is
ause the system to “crash”.
S

ystem Map: Right View 

2
1

Changing DVD Regional Codes

Go to the Control Panel and double-click System >
Hardware (tab), click Device Manager, then click
the + next to DVD/CD-ROM drives. Double-click on
the DVD-ROM device to bring up the Properties di-
alogue box, and select the DVD Region (tab) to
bring up the control panel to allow you to adjust the
regional code (see “DVD Regional Codes” on
page 2 - 5).

DVD region detection is device dependent, not OS-
dependent. You can select your module’s region
code 5 times. The fifth selection is permanent. This
cannot be altered even if you change your operating
system or you use the module in another computer.

CD E

If you need to manually
pected power interruptio
ened paper clip into th
sharpened pencil or sim
lodged in the hole. 

M

Don’t try to remove a fl
accessing it. This may c

3 4
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3
4

5

5

3

the computer with battery power until it
 charging indicator light changes from

y 30 days or after about 20 partial dis-

4

1
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ystem Map: Bottom View 
Figure 1 - 7 - Bottom View

. Vent/Fan Intake

. Modem/Bluetooth & 
Modem Combo Module 
Cover

. CPU Cover

. Hard Disk/Memory/WLAN 
(RAM) Cover

. Battery Cover

2

1
CPU

The CPU is not a user ser-
viceable part. Opening this
compartment, or access-
ing the CPU in any way,
may violate your warranty.

Overheating

To prevent your computer
from overheating make
sure nothing blocks the
vent/fan intake while the
computer is in use.

Battery Information

Always completely discharge, then fully charge, a new battery before using it. Use 
shuts down due to a low battery. When charging the battery, don’t stop until the LED
orange to green. Completely discharge and charge the battery at least once ever
charges. See “Battery Information” on page 4 - 9 for full instructions.
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W
M d most other Windows versions) are
ac y will be installed on your hard disk
d sktop. You can customize the look of
th  from the menu.

In en the Control Panel. The Control
P  settings for most of the key features
in s basic controls for many of the fea-
tu d) when you install the drivers listed
in gle off Category View.

anel

lick here to toggle Category View
Windows XP Star

indows XP Start Menu & Control Panel
ost of the control panels, utilities and programs within Windows XP (an
cessed from the Start menu. When you install programs and utilities the

rive, and a shortcut will usually be placed in the Start menu and/or the de
e Start menu by right-clicking the Start menu and selecting Properties

 many instances throughout this manual you will see an instruction to op
anel is accessed from the Start menu, and it allows you to configure the
 Windows (e.g. power, video, network, audio etc.). Windows XP provide
res, however many new controls are added (or existing ones are enhance
 Table 5 - 1, on page 5 - 6. To see all controls it may be necessary to tog

Figure 1 - 8 - Start Menu & Control P

C
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V
Y Display Properties control panel in
W ation see “Video & Audio Controls”
o

 to Settings and click Control Panel 
 Panel).
play (icon); Display (icon) is in the 
d Themes category.

ab) in the Display Properties dialog 

o the preferred setting in Screen area/

nd scroll to the preferred setting In 
ality .
ess Display Properties by right-
top and scrolling down and clicking 
k Settings (tab) and adjust as above.
y Properties control panel, and click 
n)  to bring up the Advanced 

 Clicking through these tabs allows 
 video adjustments you require.
 Display Properties Desktop

2

3

 - 14 Video Features

Quick Start Guide

ideo Features
ideo Driver Controls
ou can switch display devices, and configure display options, from the 
indows as long as the video driver is installed. For further video inform

n page 3 - 1.
1. Click Start, point

(or click Control
2. Double-click Dis

Appearances an
3. Click Settings (t

box.
4. Move the slider t

resolution .
5. Click the arrow, a

Colors/Color qu
6. You can also acc

clicking the desk
Properties. Clic

7. Open the Displa
Advanced (butto
properties tabs.
you to make any

Figure 1 - 9 -

1

Right-Click
Desktop

21

3
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D
B  TV as your display device. A VGA
m -Out Jack. With the video driver in-
st trols to switch between the displays
m

Win XP Win 2000

ice

 act as a X
isplay Devices & Options
esides the built-in LCD, you can also use an external VGA monitor or
onitor connects to the external monitor (VGA) port, a TV to the S-Video
alled (see “What to Install” on page 4 - 1), you can use its built-in con
odes indicated in the table below.

Table 1 - 5 - Display Options

Display Mode Description

Single One of the connected displays is used as the display dev

Dual Display 
Clone Both connected displays output the same view

Extended Desktop Both connected displays are treated as separate devices, and
virtual desktop
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1
P
T ou to configure power management
fe mponents such as the monitor or hard
d Hibernate mode to conserve power
th s pictured in Figure 1 - 10). Pay at-
te e 4 - 9.

T , and Lid Sensor may be set to send
th

P
P ower Schemes” on page 4 - 4). 
 - 16 Power Management Features

Quick Start Guide

ower Management Features
he Power Options control panel in Windows (see page 1 - 12) allows y
atures for your computer. You may conserve power through individual co

isk (by means of Power Schemes), or you may use either Standby or 
roughout the system (enable Hibernate support from the control panel a
ntion to the instructions on battery care in “Battery Information” on pag

Figure 1 - 10 - Power Options
he computer’s power button, sleep button (Fn + F4 key combination)
e computer in to either Standby or Hibernate mode.

ower Saving and Performance
ower Schemes may have an affect on your computer performance (see “P



Features & Components

Overview 2 - 1

2ents

ompo-
Chapter 2: Features & Compon
Overview
Read this chapter to learn more about the following main features and c
nents of the computer:

• The Hard Disk Drive
• The Optical (CD/DVD) Device
• The 4-in-1 Card Reader
• The PC Card Slot
• The Hot Keys
• The Check Mail Program
• The TouchPad & Buttons/Mouse
• Adding a Printer (general guidelines)



Features & Components

2

2
ata in the computer. The hard disk
 IDE hard disk drives with a height

ttom of your computer as seen be-
rting the hard disk are available in
age 7 - 4.

Hard Disk

1

- 2 Hard Disk Drive

Hard Disk Drive
The hard disk drive is used to store your d
can be taken out to accommodate other 2.5"
of 9.5 mm.

The hard disk  is accessible from the bo
low. Further details on removing and inse
“Upgrading the Hard Disk Drive(s)” on p

Power Safety

Before attempting to
access any of the inter-
nal components of
your computer please
ensure that the ma-
chine is not connected
to the AC power, and
that the machine is
turned off. Also ensure
that all peripheral ca-
bles, including phone
lines, are disconnected
from the computer.

Figure 2 - 1
Hard Disk Location

1
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Optical Device 2 - 3

2
he ac-

page C
ed as a
6 - 8).

/DVD
he disc
its lock
 while
ing. If
ed pa-

Sound Volume 
Adjustment

How high the sound
volume can be set de-
pends on the setting of
the volume control
within Windows. Click
the Volume icon on
the taskbar to check
the setting. 

Peripherals must be
connected before you
turn on the system.

Figure 2 - 2
Optical Device
Optical Device
There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). T
tual device will depend on the model you purchased (see “Storage” on 
- 3). The optical device is usually labeled “Drive D:” and may be us
boot device if properly set in the BIOS (see “Startup Menu” on page

Loading Discs
To insert a CD/DVD, press the open button  and carefully place a CD
onto the disc tray with label-side facing up (use just enough force for t
to click onto the tray’s spindle). Gently push the CD/DVD tray in until 
“clicks” and you are ready to start. The busy indicator  will light up
data is being accessed, or while an audio/video CD, or DVD, is play
power is unexpectedly interrupted, insert an object such as a straighten
per clip into the emergency eject hole  to open the tray.

1

2

3

1
2 3
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2

2 revent them from being damaged.
e that the data stored on your CDs/

not touch the surface of the disc.
ust or fingerprints.

o the surface of the disc.
 high-temperature areas.

eaners to clean the CD or DVD.

 to shock.
- 4 Optical Device

Handling CDs or DVDs
Proper handling of your CDs/DVDs will p
Please follow the advice below to make sur
DVDs can be accessed.

Note the following:

• Hold the CD or DVD by the edges; do 
• Use a clean, soft, dry cloth to remove d
• Do not write on the surface with a pen.
• Do not attach paper or other materials t
• Do not store or place the CD or DVD in
• Do not use benzene, thinner, or other cl
• Do not bend the CD or DVD.
• Do not drop or subject the CD or DVD

CD Emergency 
Eject

If you need to manually
eject a CD (e.g. due to
an unexpected power
interruption) you may
push the end of a
straightened paper clip
into the emergency
eject hole. However
please do NOT use a
sharpened pencil or
similar object that may
break and become
lodged in the hole.

Disk Eject Warning

Don’t try to remove a
CD/DVD while the sys-
tem is accessing it.
This may cause the
system to “crash”.
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Optical Device 2 - 5

2es” on

Table 2 - 1
DVD Regional Coding

Figure 2 - 3
DVD Regions
DVD Regional Codes
To change the DVD regional codes see “Changing DVD Regional Cod
page 1 - 11.
.

DVD Regional Coding

Region Geographical Location

1 USA, Canada

2 Western Europe, Japan, South 
Africa, Middle East & Egypt

3
South-East Asia, Taiwan, 

South Korea, The Philippines, 
Indonesia, Hong Kong

4
South & Central America, 

Mexico, Australia, 
New Zealand

5 N Korea, Russia, Eastern 
Europe, India & Most of Africa

6 China
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2

2
he latest digital storage cards. Push
 removable device.

n the computer and can be accessed

Card Reader Cover

Make sure you keep the
cover in the card reader
when not is use. This will
help prevent foreign objects
and/or dust getting in to the
card reader.
- 6 4-in-1 Card Reader

4-in-1 Card Reader
The card reader allows you to use some of t
the card into the slot and it will appear as a

• MMC (MultiMedia Card)
• SD (Secure Digital)
• MS (Memory Stick)
• MS (Memory Stick Pro)

The cards will appear as removable disks o
in the same way as your hard disk (s).

Figure 2 - 4
Removable Disks
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PC Card Slot 2 - 7

2
 II PC
nstall”

ce.
lot.

Figure 2 - 5
PC Card Slot
PC Card Slot
The computer is equipped with a PCMCIA 3.3V/5V slot for one type
Card. Make sure you install the driver for the PC Card (see “What to I
on page 5 - 1).

Inserting and Removing PC Cards 
• Align the PC Card with the slot and push it in until it locks into pla
• To remove a PC Card, simply press the eject button  next to the s1

1



Features & Components

2

2
inations, enhanced Hot Key func-

stalled (see “What to Install” on

 will appear in the taskbar. Dou-
ion menu. The configuration menu
 menus to be displayed on screen.
u click the close icon  you will
rt menu in Windows (Start > Pro-
y Driver).
- 8 Hot Keys

Hot Keys
In addition to the basic function key comb
tions are available when the driver is in
page 5 - 1).

After installing the Hot Key driver an icon 
ble-click the icon to bring up the configurat
allows you to set the time for the specific
Click OK to minimize the program. If yo
need to run the program again from the Sta
grams/All Programs > Startup > HotKe

Application Note

The Hot Key functions
(see “HotKey/Quick-
Key Functions” on
page 2 - 9) will only be
displayed if the pro-
gram is running (i.e.
the icon  is displayed
in the taskbar). If you
have closed the pro-
gram you can run it
again from the Start
menu (Start > Pro-
grams > Startup >
HotKey Driver) in
Windows.

Figure 2 - 6
HotKey Driver 

Configuration & Help 
Menu
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Hot Keys 2 - 9

2

e 2 - 8

Table 2 - 2
HotKey/Quick-Key 

Functions

Hot Key Note

The Help menu will dis-
play the function key
features, current Bat-
tery Life, Power State
and CPU Temperature
information. When you
plug-in/remove the AC
adapter to/from the
DC-In Jack, the CPU
SpeedStep mode will
be displayed (see
“CPU SpeedStep
Controls (Power
Menu)” on page 6 -
14).
Hot Key / 
Quick-Key Function

Fn + F1 Activate the Help Menu See Figure 2 - 6 on pag

Fn + F8 Decrease LCD Brightness

Fn + F9 Increase LCD Brightness

Plug-In/Remove AC 
Adapter 

Displays CPU SpeedStep 
Mode

Displays WLAN Module 
Power State

Displays PC Camera 
Module Power State

Displays Bluetooth Module 
Power State
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2
heck Mail program (see “What to

figure it to give notification when
 receive this notification (note that
tocol), and your default mail pro-

efault settings, the CheckMail pro-
 Programs/All Programs > Star-
- 10 Check Mail Program

Check Mail Program
After you have installed the driver for the C
Install” on page 5 - 1) you may then con
new mail is received. You must be online to
this program only supports the POP3 pro
gram does not need to be open.

If you have installed the driver using the d
gram appears in the Startup menu (Start >
tup > CheckMail).

Figure 2 - 7
Check Mail Program 

(Startup Menu)
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Check Mail Program 2 - 11

2

d pass-
 server
he set-
rogram
u click
he pro-

Note

Check with your Inter-
net Service Provider,
network administrator
or Mail Service provid-
er for details on what to
put on these pages.

Figure 2 - 8
 Check Mail 

Account Setup and 
Options
Clicking on Check Mail will bring up the following options menu. 

You may then configure the options for your mail server, user name, an
word. Click Enable Check Mail to have the program check the mail
for new mail, and set the interval (in seconds). Click SAVE to keep t
tings, and Hide to minimize the program. After clicking Hide, the p
will be accessible by double-clicking the icon  in the taskbar. If yo
the close icon  in the Check Mail control panel you will need to run t
gram again from the Start menu in Windows.
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2

2

eived mail by clicking on Set Mail
 to use for mail notification. Click
AVE to save the settings.
- 12 Check Mail Program

You may enable an audible warning for rec
Wave, and browsing to a .WAV sound file
Enable play wave for mail arrival, and S

Figure 2 - 9
Check Mail Enabled

Figure 2 - 10
Set Mail Wave
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ad and Buttons/Mouse 2 - 13

2
 on the
d pres-
ouse to

mouse.
Figure

Mouse Driver

If you are using an ex-
ternal mouse your op-
erating system may be
able to auto-configure
your mouse during its
installation or only en-
able its basic functions.
Be sure to check the
device’s user docu-
mentation for details.
TouchP

TouchPad and Buttons/Mouse
The TouchPad is a device for pointing (controlling input positioning)
computer’s display screen by sensing finger movement, and downwar
sure. It is an alternative to the mouse; however, you can also add a m
your computer through one of the USB ports.

The TouchPad buttons function in much the same way as a two-button 
The central button may be configured to function as you require (see 
2 - 11 on page 2 - 14 for screen examples).
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2

2  Buttons
rivers (see “What to Install” on

s by double-clicking the TouchPad
n configure the TouchPad tapping,
itivity options to your preferences.
t www.synaptics.com.
- 14 TouchPad and Buttons/Mouse

Configuring the TouchPad and
Once you have installed the TouchPad d
page 5 - 1) you can configure the function
driver icon  on the taskbar. You may the
buttons, scrolling, pointer motion and sens
You will find further information on this a

Figure 2 - 11
Mouse Properties
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Adding a Printer 2 - 15

2
entions
 printer

 one of

 toner/

puter.
s or 

 in the

Parallel Printer

After setting up the
printer attach the paral-
lel cable to the printer.

Connect the printer’s
parallel cable to the
Parallel port.

Turn ON the printer,
then the computer.

Windows will identify
the printer and either
load one of its own
drivers or ask you to
supply one. Follow the
on-screen instructions.
Adding a Printer
The most commonly used peripheral is a printer. The following conv
will help you to add a printer, however it is always best to refer to the
manual for specific instructions and configuration options.

USB Printer
Most new printers have a USB interface connection. You may use any
the ports to connect the printer.

Install Instructions:
1. Set up the printer according to its instructions (unpacking, paper tray,

ink cartridge etc.). 
2. Turn ON the computer.
3. Turn ON the printer. 
4. Connect the printer’s USB cable to one of the USB ports on the com
5. Windows will identify the printer and either load one of its own driver

ask you to supply one. Follow the on-screen instructions.

Parallel Printer
This is still a very common type of printer. The install instructions are
sidebar.
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Overview 3 - 1

3

ols

crosoft

Drivers

You are unable to use
most advanced con-
trols until the neces-
sary drivers and
utilities are properly in-
stalled. If your system
hasn’t been properly
configured (your ser-
vice representative
may have already
done that for you), re-
fer to “What to In-
stall” on page 5 - 1 for
installation instruc-
tions.

LCD
 ac-
Chapter 3: Video & Audio Contr
Overview
This chapter covers:

• Keyboard Video Controls
• Dynamic Video Memory Technology
• Display Properties
• Intel Extreme Graphics 2 for Mobile
• Display Devices
• Multi Monitor Modes
• TV System
• Audio Features

Note: All operating system pictures in this manual are from the Mi
Windows XP OS.

Protecting the LCD

Do not allow any foreign objects (i.e. paper or plastic) to get between the lid/
and the work panel. They could damage or scratch the LCD and/or accidentally
tivate the Lid Sensor.
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3

3

ls
or the LCD, and switching display
ith the Fn + Display (F7) toggle.

k at the screen straight on, without
s controls (Fn + F8/F9). If the Hot
ar on screen to indicate the level of
 key combination (see “Hot Keys”
- 2 Advanced Video Controls

Advanced Video Contro
This section is about making adjustments f
devices. You can switch display devices w

Keyboard Video Controls
As you open the lid, adjust it so you can loo
any glare. If necessary, adjust the brightnes
Key driver is installed indicators will appe
brightness when you press the Fn + F8/F9
on page 2 - 8).

Protecting the LCD

Do not allow any for-
eign objects (i.e. paper
or plastic) to get be-
tween the lid/LCD and
the work panel. They
could damage or
scratch the LCD and/or
accidentally activate
the lid sensor.

Figure 3 - 1
Brightness 

Controls

F9F8F7

Fn
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dvanced Video Controls 3 - 3

3
64MB)
r must
atever

VMT

DVMT Notes

DVMT is not user-con-
figurable.

DVMT is not local vid-
eo memory.

DVMT will not function
in MS-DOS. DOS uses
the legacy memory in-
dicated.

*Note: The video driv-
ers for Windows 2000
require Service Pack 1
or later to run correctly.
Check with the Mi-
crosoft Windows 2000
support site for the lat-
est updates.

Table 3 - 1
DVMT Memory 
Requirements
A

Dynamic Video Memory Technology
Intel® DVMT automatically and dynamically allocates as much (up to 
system memory (RAM) as needed to the video system (the video drive
be installed - see “What to Install” on page 5 - 1). DVMT returns wh
memory is no longer needed to the operating system.

System Memory Maximum Memory Allocated for Graphics by D

0MB - 127MB Not Supported

128 MB - 256MB 32MB

256MB - Maximum Memory 64MB

Information Tab

The information tab in Intel(R) 82852/
82855 GM/GME Graphics Controller
Properties (Control Panel) lists details
of your computer’s memory etc. See “In-
tel Extreme Graphics 2 for Mobile” on
page 3 - 6 to see how to access this Infor-
mation tab.
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3

3
reen resolution and color output to
 you. This is a matter of hardware,
rating system. The driver interface
ions” on page  C - 2 for LCD spec-

isplay Properties control panel in
stalled (see “What to Install” on

splay
for, the more information the LCD
’s resolution and color depth go to

ontrol Panel (or click Control 

in Appearance and Themes 

lick Settings (tab).
ve the slider to the preferred setting 
n page 3 - 5).
 and scroll to the preferred setting 
on page 3 - 5).
- 4 Display Properties

Display Properties
The video interface lets you change the sc
whatever is most comfortable/efficient for
video memory and the driver for your ope
shows the available options (see “LCD Opt
ifications).
You can switch display devices from the D
Windows as long as the video driver is in
page 4 - 1).

Making Adjustments for the Di
The higher the resolution you set the LCD 
can display on screen. To change the LCD
the Display Properties control panel:
1. Click Start, point to Settings and click C

Panel).
2. Double-click Display (icon); Display is 

(category).
3. In the Display Properties dialog box, c
4. In Screen area/Screen resolution, mo

for resolution (see  in Figure 3 - 2 o
5. In Colors/Color quality, click the arrow

for color depth (see  in Figure 3 - 2 

Screen Resolution/
Screen Area Note

You may set the reso-
lution to a higher set-
ting than the panel
supports, however this
will require you to pan
(scroll) around the
screen as the display
area will be larger than
what you can see on
the LCD.

1

2



Video & Audio Controls

Display Properties 3 - 5

3

ced 
ws you
 on the

Figure 3 - 2
Display Properties

&
Advanced Options

Intel(R) Extreme 
Graphics 2 for 

Mobile

You can click Graph-
ics Properties (but-
ton) in the Intel(R)
Extreme Graphics 2
for Mobile tab (in the
Display Properties >
Advanced options) to
access the screens in
Figure 3 - 4 on page 3
- 7.

3
When the Display Properties control panel is open, click the Advan
(button) to bring up the options tabs. Clicking through these tabs allo
to make any video adjustments you require (see sidebar for information
Intel driver controls).

2

3

1
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obile
l be an additional control panel en-
cess the control panel as follows: 

d click Control Panel (or click Con-

s 2M (icon) to bring up the Intel(R) 
roller Properties (click Switch to 
ns).
- 6 Display Properties

Intel Extreme Graphics 2 for M
After installing the video driver there wil
titled Intel(R) Extreme Graphics 2M. Ac

1. Click Start (menu), point to Settings an
trol Panel).

2. Double-click Intel(R) Extreme Graphic
82852/82855 GM/GME Graphics Cont
Classic View if you don’t see all the ico

Taskbar Icon

You can also access
the controller proper-
ties from the taskbar.
Click on the icon to
bring up the menu and
scroll to Graphics Op-
tions > Graphics
Properties.

If you cannot see the
tray icon go to the In-
tel(R) Extreme
Graphics 2 for Mobile
tab (in the Display
Properties > Ad-
vanced options) and
click the “Show Tray
Icon” tickbox.

Figure 3 - 3
Intel Extreme 

Graphics Control 
Panel
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licking
forma-
roper-

eblinks
e Intel

Figure 3 - 4
Intel 82852/82855 

GM/GME Graphics 
Controller Properties
You may make changes to the Devices, Color, Schemes, Hot Keys by c
the appropriate tab and adjusting the setting, then clicking OK. The In
tion and Open GL tabs display useful information about the graphics p
ties of the computer, and the Support item in the Information tab has w
to the latest information (drivers, troubleshooting issues etc.) on th
Website.
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or applications which require spe-
 to run properly e.g. games, multi-

E Graphics Controller Properties 
hics 2 for Mobile” on page 3 - 6).

pe a name in the dialog box that 

d in the Schemes box, and choose 
o Modes box.

plication you want to set a scheme 
ct it.
 click in the "Reset On Exit" box to 
 exit the program).
ct it from the Schemes box and 

gram in the chosen video setting 
lay Modes by clicking on the icon 
of the screen).
- 8 Display Properties

Schemes
Use Schemes to configure quick settings f
cific resolution and color settings in order
media programs. To set the schemes:

1. Go to the Intel(R) 82852/82855 GM/GM
control panel (see “Intel Extreme Grap

2. Click on Schemes (tab).
3. Select New to setup the scheme, and ty

pops up, then click OK.
4. Click on the scheme name you had type

the option you wish to use from the Vide
5. Browse to the executable file for the ap

for (see sidebar), and click Open to sele
6. Click Save to save the settings (you can

return to your original settings when you
7. When you want to run the program, sele

click "Invoke" to run the highlighted pro
(alternatively you can select it from Disp
option in the taskbar at the bottom right 

Application.exe

You will need to locate
the actual application
executable (.exe) file,
not just the shortcut.
To find the application
right-click its shortcut
on the desktop click
Properties. Click the
Shortcut (tab) and see
where the executable
file is located by click-
ing the Find Target
(button). Note the loca-
tion and you will then
be able to browse to
this file. 
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.
ly, the 
lay 

Using the Driver to 
Switch Displays

If you only use the key-
board toggle to switch
through the display op-
tions you will not have
all the configuration
options available to
you. If you want to ac-
cess the options listed
here use the driver
control panel to config-
ure the settings as per
“Switching/Enabling
Displays (Driver)” on
page 3 - 10.

Figure 3 - 5
Left Side View
Display Devices
Besides the built-in LCD, you can also use an external VGA monitor
as your display device. A VGA monitor connects to the external m
(VGA) port , a TV to the S-Video-Out Jack .

Switching/Enabling Displays (Keyboard)
You can switch display devices with the Fn + Display (F7) toggle. W
video driver installed, you also can use its built-in controls to switch t
play options. If you haven’t installed the video driver, refer to (see “W
Install” on page 4 - 1) for setup instructions. To switch the display op

1. Plug the VGA monitor and/or TV into the appropriate port/jack.
2. Press and hold the Fn key, while simultaneously pressing the F7 key
3. You may toggle through the options to display the notebook’s LCD on

external display alone, and the notebook’s LCD and the external disp
together (make sure you allow time for the screens to refresh).

1 2

2 1
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river)
t to Install” on page 5 - 1), you can
the displays as follows:

ropriate port/jack (see page 3 - 9).
E Graphics Controller Properties 
hics 2 for Mobile” on page 3 - 6) 

n the left and click Apply (and OK 

 or Secondary.

on enabling Clone and Extended
- 10 Display Devices

Switching/Enabling Displays (D
With the video driver installed (see “Wha
use its built-in controls to switch between 

1. Plug the VGA monitor or TV into the app
2. Go to the Intel(R) 82852/82855 GM/GM

control panel (see “Intel Extreme Grap
and select Devices (tab).

3. Choose the display option from the list o
to confirm the settings change).

4. You can choose a device to be Primary

See the following pages for instructions 
Desktop modes.

Vertical Refresh 
Rate

The vertical refresh rate
of your monitor is impor-
tant. If it is too low and/or
you’re using fluorescent
lighting, the screen will
appear to flicker. To re-
duce flickering on a moni-
tor, use faster refresh
rates (we recommend a
refresh rate of 72Hz or
more). But first check
your monitor’s documen-
tation to make sure it can
support the rates listed by
the video driver. The de-
fault refresh rate for mon-
itors (without drivers) is
60Hz.

Figure 3 - 6
Switching Display 

Settings
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Multi-Monitor Modes
In addition to the single LCD display mode you have the following 
Monitor modes available when an external monitor or TV is attached

Intel(R) Dual Display Clone
This mode will drive multiple displays with the same content. Use this 
to display the screen through a projector for a presentation.

Extended Desktop
This mode allows a desktop to span multiple displays and acts as a large
space. This creates a lot more screen area for display. Use the Display
erties control panel to drag the monitors to match the physical arrang
you wish to use, or you may also use the Extended Desktop Settings 
panel tab in Intel(R) 82852/82855 GM/GME Graphics Controller P
ties to configure the relative size and position.
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ropriate port/jack (see page 3 - 9).
E Graphics Controller Properties 
hics 2 for Mobile” on page 3 - 6) 

con in the devices tab (Note: this 
ttached a monitor or TV).
ry display, and which is to be 

e Settings (button) if necessary.
 panels.
- 12 Display Devices

To Enable Dual Display Clone Mode:
1. Plug the VGA monitor or TV into the app
2. Go to the Intel(R) 82852/82855 GM/GM

control panel (see “Intel Extreme Grap
and select Devices (tab).

3. Click the Intel(R) Dual Display Clone i
option is only available when you have a

4. Choose which device is to be the Prima
Secondary.

5. Adjust the settings by clicking the Devic
6. Click Apply > OK and close the control

Figure 3 - 7
Device Settings 

(Clone Mode)
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3 - 6) 

n is 

 

ary.

perties

Figure 3 - 8
Device Settings 

(Extended Desktop 
Mode)

 Device Settings 
Extended Desktop 

You can have different
Colors, Screen Area
and Monitor Refresh
Rates for each display
device provided your
monitor can support
them.

You can drag the mon-
itor icons to match the
physical layout of your
displays. Icons and
programs may also be
dragged between the
displays.

and 
ment 
 dis-
 right 
To Enable Extended Desktop Mode:
1. Plug the VGA monitor or TV into the appropriate port/jack (see page 
2. Go to the Intel(R) 82852/82855 GM/GME Graphics Controller Prop

control panel (see “Intel Extreme Graphics 2 for Mobile” on page
and select Devices (tab).

3. Click the Extended Desktop icon in the devices tab (Note: this optio
only available when you have attached a monitor or TV).

4. Choose which device is to be the Primary display, and which is to be
Secondary.

5. Adjust the settings by clicking the Device Settings (button) if necess
6. Click Apply > OK and close the control panels.

You can also enable the Extended Desktop mode from the Display Pro
control panel (see “Display Properties” on page 3 - 4).

Click the appropriate monitor icon 
drag it to match the physical arrange
you wish to use (e.g. the secondary
play may be extended to the left or
of the primary display).

Click Device Settings to make 
adjustments to the display settings.
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 Properties)
ropriate port/jack (see page 3 - 9).
k Control Panel) and click Control 
ose Appearance and Themes).

lick Settings (tab).
e sure you have checked “Extend 
tor.” and click Apply.

rs to match the physical 
mple shown in Figure 3 - 9 the 

ondary display is on the right. You 
o either display desktop, which 
visible in one of the displays, and a 
play.

 the appropriate monitor
o be able to select the op-
o extend the desktop on
- 14 Display Devices

To Enable Extended Desktop (Display
1. Plug the VGA monitor or TV into the app
2. Click Start, point to Settings (or just clic

Panel (if you are in Category View cho
3. Double-click Display (icon).
4. In the Display Properties dialog box, c
5. Click the monitor icon (e.g. ), and mak

my Windows desktop onto this moni

6. Use the control panel to drag the monito
arrangement you wish to use. In the exa
primary monitor  is on the left, the sec
can drag any icons or windows across t
makes it possible to have one program 
different program visible in the other dis

Figure 3 - 9
Display Properties 
(Extended Desktop 

Mode)

2

Click
icon t
tion t
to it.

1
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Figure 3 - 10
TV Video Standard
TV System
If you are using a TV as a display device you may change the video st
to NTSC or PAL as follows:

1. Plug the VGA monitor or TV into the appropriate port/jack (see page 
2. Go to the Intel(R) 82852/82855 GM/GME Graphics Controller Prop

control panel (see “Intel Extreme Graphics 2 for Mobile” on page
and select Devices (tab).

3. Choose the display mode (Television, Clone or Extended Desktop
set the device to be Primary or Secondary if required.

4. Adjust the settings by clicking the Device Settings (button).
5. Choose the appropriate TV system from Video Standard dropbox.
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ur computer from the Sounds and
ia  Windows control panel (see
dio controls are available from the
ar/control panel, and the AV Rack

e volume by means of the Fn + F5/
- 16 Audio Features

Audio Features
You can configure the audio options on yo
Audio Devices  /Sounds and Multimed
Figure 1 - 8 on page 1 - 13). Additional au
Sound Effect Manager  icon in the taskb
program  icon on the desktop. Adjust th
F6 key combination.

Sound Volume 
Adjustment

How high the sound
volume can be set us-
ing the volume control
knob depends on the
setting of the volume
control within Win-
dows. Click the
Speaker icon on the
taskbar to check the
setting.

Figure 3 - 11
Audio 

Configuration 
Controls
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er and

S to set
om ap-
.

OS Note

Power management
functions will vary
slightly depending on
your operating system.
For more information it
is best to refer to the
user’s manual of your
operating system. 

(Note: All pictures
used on the following
pages are from the
Windows XP OS.)
Chapter 4: Power Management
Overview
To conserve power, especially when using the battery, your computer u
ACPI power management system. Power management conserves po
controlling individual components of the computer (the monitor and ha
drive) or the whole system.

This chapter covers:

• The Power Sources
• Turning On the Computer
• Power Schemes
• System Power Options (Standby and Hibernate)
• Configuring the Power Button
• Battery Information

Advanced Configuration and Power Interface
The ACPI interface provides the computer with enhanced power savin
niques and gives the operating system (OS) direct control over the pow
thermal states of devices and processors. For example, it enables the O
devices into low-power states based on user settings and information fr
plications. ACPI is fully supported in Windows 2000 and Windows XP
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 AC adapter or a battery pack.

your computer. The wrong type of
 its components.

 at the rear of the computer.
nd then connect the AC power cord 

ing angle.

uter while you are on the road or
attery life varies depending on the
sing. To increase battery life, let
 recharging (see “How do I com-
- 12).

e battery. For more information on
ation” on page 4 - 9.
- 2 The Power Sources

The Power Sources
The computer can be powered by either an

AC Adapter
Use only the AC adapter that comes with 
AC adapter will damage the computer and

1. Attach the AC adapter to the DC-in jack
2. Plug the AC power cord into an outlet, a

to the AC adapter.
3. Raise the lid/LCD to a comfortable view
4. Press the power button to turn “On”.

Battery
The battery allows you to use your comp
when an electrical outlet is unavailable. B
applications and the configuration you're u
the battery discharge completely before
pletely discharge the battery?” on page 4 

We recommend that you do not remove th
the battery, please refer to “Battery Inform

Power Button as 
Standby or 

Hibernate Button

If you are using a fully
ACPI-compliant OS,
(such as Windows
2000 Professional, or
Windows XP) you can
use the OS’s “Power
Options” control panel
to set the power button
to send the system into
Standby or Hibernate
mode (see your OS’s
documentation, or
“Configuring the
Power Button” on
page 4 - 8 for details).
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y press

/Hiber-
econds
e com-
nfigure

Shutdown

Note that you should
always shut your com-
puter down by choos-
ing the Shut Down/
Turn Off Computer
command from the
Start menu in Win-
dows. This will help
prevent hard disk or
system problems.

ress
.

T

Turning on the Computer
Now you are ready to begin using your computer. To turn it on simpl
the power button on the front panel.

When the computer is on, you can use the power button as a Standby
nate/Shutdown hot-key button when it is pressed for less than 4 s
(pressing and holding the power button for longer than this will shut th
puter down). Use Power Options in the Windows control panel to co
this feature.

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, p
the power button for 4 seconds, or longer, to force the system to turn itself off
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er through individual components
 also adjust the settings for each
 specified time, and the computer's
 drive has not been accessed for a
 or writes data, the hard disk motor
 also be set to set a specified time
te modes (see “System Power Op-
- 4 Power Schemes

Power Schemes
You can set your computer to conserve pow
by means of Power Schemes. You can
scheme to set the monitor to turn off after a
hard disk motor to turn off if the hard disk
specified period of time (if the system reads
will be turned back on). The schemes may
for the system to enter Standby or Hiberna
tions” on page 4 - 6).

Resuming 
Operation

The system can re-
sume from Monitor or
Hard Disk Standby by
pressing a key on the
keyboard.

Figure 4 - 1
Power Schemes
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CPU SpeedStep 
Controls & CPU 

Performance

If you have a Pentium
M processor, the set-
tings for CPU Speed-
Step Controls will
have an affect on the
CPU’s speed and per-
formance (in order to
save power under cer-
tain conditions). See
“Intel CPU Speed-
Step Controls” on
page B - 3 for more
details on how the set-
tings control the CPU
speed and perfor-
mance. If you have a
Celeron M Processor
the settings are emu-
lated by CPU throttling.
Each Windows Power Scheme will also adjust the processor performa
your machine in order to save power. This is worth bearing in mind if y
experiencing any reduced performance (especially under DC/battery p

Choose the Home/Office Desk scheme for maximum performance wh
computer is powered from an AC power source. Choose the Max B
scheme (bear in mind that this scheme may slow down the overall 
mance of the computer in order to save power) for maximum power 
when the computer is battery (DC power) powered. Windows will use 
ble/Laptop as the default scheme.

For advanced information see “Power Schemes and Processor P
mance” on page B - 2.
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stop the computer’s operation and
ures Standby and Hibernate sleep
 be enabled by clicking the option

ns control panel - Figure 4 - 2 on

e in that the system is off and you
. Their main difference is:

u can return to where you last left
 reopening the application(s) and

our needs. 

ode
r just a while, you can put the sys-
 takes a longer time to wake up the
tandby mode.
- 6 System Power Options

System Power Options
You can use the system power options to 
restart where you left off. This system feat
mode levels (Hibernate mode will need to
in the Hibernate tab in the Power Optio
page 4 - 7).

Hibernate Mode vs. Shutdown
Hibernate mode and Shutdown are the sam
need to press the power button to turn it on

When you come back from hibernation, yo
off (what was on your desktop) without
file(s) you last used.

You can use either method depending on y

Standby Mode vs. Hibernate M
If you want to stay away from your work fo
tem on standby instead of in hibernation. It
system from Hibernate mode than from S
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 return
CPU is
memo-
 which
ower. 

 of the
it takes
 to au-
pleted.
 Power
ode by

System Resume

The system can resume
from Standby mode by:

• Pressing the power
button

• Pressing a key on the
keyboard

• An alarm resume that
is enabled and expires

• An incoming call
received on the
modem (if enabled)

• Network card activity
(if enabled)

Figure 4 - 2
Enable Hibernation
Standby
Standby saves the least amount of power, but takes the shortest time to
to full operation. During Standby the hard disk is turned off, and the 
made to idle at its slowest speed. All open applications are retained in 
ry. When you are not using your computer for a certain length of time,
you specify in the operating system, it will enter Standby mode to save p

Hibernate
Hibernate uses no power and saves all of your information on a part
HDD before it turns the system off. Although it saves the most power 
the longest time to return to full operation. You can set your computer
tomatically enter Hibernate mode when the battery power is almost de
You will need to enable Hibernate mode from the Hibernate tab in the
Options control panel. The system will resume from Hibernate m
pressing the power button.
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utton
mputer in to either Standby or Hi-
 mode, the LED  will flash

e off. If you are in a power saving
l components (e.g. hard disk, mon-

(Sleep) Button

ton

key combination (Fn + Esc) from the
this is referred to as the Sleep button.

Sleep/Resume
- 8 Configuring the Power Button

Configuring the Power B
The power button may be set to send the co
bernate mode (Figure 4 - 3). In Standby
green. In Hibernate mode the LED will b
mode set to save power through individua
itor), the LED will remain green.

Figure 4 - 3
Power Options

(Advanced - Power 
Buttons)

Sleep But

You may also configure the Sleep/Resume 
menu illustrated in Figure 4 - 3. In Windows 

Power Button Lid
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ttery.

attery

ing the
ptions
Meter
lp pro-

Low Battery 
Warning

When the battery is
critically low, immedi-
ately connect the AC
adapter to the comput-
er or save your work,
otherwise, the un-
saved data will be lost
when the power is de-
pleted.

Figure 4 - 4
Power Options 
(Alarm & Power 

Meter)
Battery Information
Please follow these simple guidelines to get the best use out of your ba

New Battery
Always completely discharge, then fully charge, a new battery (see “B
FAQ” on page 4 - 12 for instructions on how to do this).

Battery Life
Your computer’s battery life is dependent upon many factors, includ
programs you are running, and peripheral devices attached. Power O
(you may set low battery Alarms and actions, and check the Power 
from the Power Options control panel), and settings in the OS will he
long the battery life if configured appropriately.
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proper maintenance. To optimize
ully discharge and recharge the

 battery yourself. If you do need to
oving the Battery” on page 7 - 3.

e AC Adapter
hen the AC adapter is attached and
puter is powered on, and in use, it
he battery. When the computer is
let, battery charge time is less. (Re-
 information on the battery charge
age 4 - 9 for more information on
 battery pack.)
- 10 Battery Information

Battery life may be shortened through im
the life and improve its performance, f
battery at least once every 30 days.

We recommend that you do not remove the
remove the battery for any reason see “Rem

Recharging the Battery with th
The battery pack automatically recharges w
plugged into an electrical outlet. If the com
will take several hours to fully recharge t
turned off but plugged into an electrical out
fer to “LED Indicators” on page 1 - 6 for
status, and to “Battery Information” on p
how to maintain and properly recharge the

Conserving 
Battery Power

To conserve battery pow-
er:

Lower the brightness lev-
el of the LCD display. The
system will decrease LCD
brightness slightly to save
power when it is not pow-
ered by the AC adapter.

Close modem or commu-
nication applications
when they are not being
used.

Remove any unused PC
Cards from the computer
(PC Cards quickly use up
battery power even if the
system enters sleep
mode).

Disconnect any unneces-
sary external devices.
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Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may exp
• DO NOT connect the metal terminals (+, -) to each other

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape 
being dropped), or any unusual smells emanating from the notebook battery, 
your computer down immediately and contact your service center. If the battery
been dropped we do not recommend using it any further, as even if the comp
continues to work with a damaged battery in place, it may cause circuit dam
which may possibly result in fire. It is recommended that you replace your comp
battery every two years.
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ry?
 it shuts down due to a low battery.
en when you see a message that in-
 the computer use up all of the bat-
able the Power Options functions
ms (unclick the tickboxes - see 4 -
Never - see page 4 - 4). As the bat-
 any critical files.

il the LED charging indicator light

ry at least once every 30 days or af-
- 12 Battery Information

Battery FAQ
How do I completely discharge the batte
Use the computer with battery power until
Don’t turn off the computer by yourself ev
dicates the battery is critically low, just let
tery power and shut down on its own. Dis
in the Control Panel, especially any Alar
9) and Schemes (change all the settings to 
tery nears the end of its life save and close

How do I fully charge the battery?
When charging the battery, don’t stop unt
changes from orange to green.

How do I maintain the battery?
Completely discharge and charge the batte
ter about 20 partial discharges.

Caution

Danger of explosion if
battery is incorrectly
replaced.

Replace only with the
same or equivalent
type recommended by
the manufacturer. Dis-
card used battery ac-
cording to the
manufacturer’s in-
structions.
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nstall
vers & Utilities + User’s Manual
ins the drivers and utilities neces-
er operation of the computer. (The
LAN module driver, and the op-
, and PC Camera module drivers

CD-ROMs supplied.) Table 5 - 1,
s what you need to install manually
ur choice of the operating system,

portant that the drivers are in-
der indicated.

er Installation
for installing drivers for the Wire-
tooth, and PC Camera modules
“Modules” on page 8 - 1. Make

vers are installed in the order indi-
 - 1, on page 5 - 6. Only install driv-
included in your purchase option.
Chapter 5: Drivers & Utilities
This chapter deals with installing the drivers and
utilities essential to the operation or improvement
of some of the computer’s subsystems. The system
takes advantage of some newer hardware compo-
nents for which the latest versions of most available
operating systems haven’t built in drivers and utili-
ties. Thus, some of the system components won’t
be auto-configured with an appropriate driver or
utility during operating system installation. Instead,
you need to manually install some system-required
drivers and utilities. In this chapter, we group driver
and utility installation instructions by operating
system. The following operating systems are cov-
ered.

• Windows 2000 Professional
• Windows XP Professional and Home Editions

What to I
The Device Dri
CD-ROM conta
sary for the prop
Intel Wireless 
tional Bluetooth
are on separate 
on page 5 - 6 list
according to yo
and it is very im
stalled in the or

Module Driv
The procedures 
less LAN, Blue
are provided in 
sure that the dri
cated in Table 5
ers for modules 
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- Navigate (Browse..) to.. 
- 2 What to Install

Navigate (Browse..) to D:

You will notice that many of the instructions for driver
installation require you to “Navigate (Browse) to D:”.
We assume that you will install all drivers and utilities
from the built-in CD device and it is assigned to “Drive
D:”. In addition, all file extensions can be seen

In this case “D:” is the drive specified for your CD de-
vice. Not all computers are setup the same way, and
some computers have the CD listed under a different
drive letter - e.g. if you have two hard drives (or hard
disk partitions) one may be designated as “Drive C:”
and the other as “Drive D:”. In this case the CD device
may be designated as “Drive E:” - Please make sure
you are actually navigating to the correct drive letter
for the CD device.

When you click the Browse (button) after clicking
Run in the Start menu you will see the “Look in:” di-
alog box at the top of the Browse window. Click the
scroll button to navigate to My Computer to display
the devices and drive letters.

Figure 5 - 1 
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ows XP Service Pack 2

install Windows XP Service Pack 2
 XP version which includes Service
e installing any drivers. Service
 support for USB 2.0.
raded the system by installing Ser-
. your Windows XP version does not
 Pack 2) then follow these instruc-

menu), point to Settings and click
l (or click Control Panel).

System (icon); System (icon) is in
 and Maintenance (category).
ware (tab) > Device Manager (but-

t to Other Devices (if its sub-items
).
iversal Serial Bus (USB) Control-

 Uninstall > OK (if you don’t see the
re is no need to take any further ac-

omputer and it will find the USB 2.0
Service Packs
Check the warnings on the following pages regard-
ing installation of the appropriate Service Pack for
your Windows OS. Make sure you have installed
the appropriate Service Pack before installing all
the drivers.

Service Pack Installed

To see which Service Pack is currently installed on
your computer go to the General tab of the System
control panel. Right-click the My Computer icon on
the desktop or in the Start menu (in WinXP only) and
select Properties. The Service Pack currently in-
stalled on your system will be listed under the “Sys-
tem:” heading. (If no Service Pack information is
listed, then no Service Pack is installed.)

Windows 2000 with Service Pack 4

Make sure that your Windows 2000 version in-
cludes Service Pack 4 on the installation CD.

Wind

Make sure you 
(or a Windows
Pack 2) befor
Pack 2 includes
If you have upg
vice Pack 2 (i.e
include Service
tions:

1.Click Start (
Control Pane

2.Double-click 
Performance

3.Click the Hard
ton). 

4.Click “+” nex
are not shown

5.Right-click Un
ler and select
item then the
tion).

6.Restart the c
controller.
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installing Individual 

pdate/reinstall individual drivers it
y to uninstall the original driver.To
Control Panel in the Windows OS
k the Add/Remove Programs
the individual driver listed (if not
nstall it, following the on screen
be necessary to restart the comput-
propriate section of the manual to
pdate/reinstall procedure for the
n.

ot listed in the Add/Remove Pro-

enu), point to Settings and click Con-
 click Control Panel). 
ystem (icon); System (icon) is in 
 and Maintenance (category).
re (tab) > Device Manager (button).
he device you wish to update/reinstall 
you may need to click “+”).
pdate Driver button (check the Driver 
 the on screen prompts.
- 4 What to Install

Authorized Driver Message
If you receive a message telling you that the driver
you are installing is not authorized (Digital Signa-
ture Not Found), just click Yes or Continue Any-
way to ignore the message and continue the
installation procedure.

You will receive this message in cases where the
driver has been released after the version of Win-
dows you are currently using. All the drivers pro-
vided will have already received certification for
Windows.

Version Conflict Message
During driver installation if you encounter any “file
version conflict” message, please click Yes to
choose to keep the existing (newer) version.

Updating/Re
Drivers
If you wish to u
may be necessar
do this go to the 
and double-clic
item. If you see 
see below), uni
prompts (it may 
er). Go to the ap
complete the u
driver in questio

If the driver is n
grams item:
1. Click Start (m

trol Panel (or
2. Double-click S

Performance
3. Click Hardwa
4. Double-click t

the driver for (
5. Look for the U

tab) and follow
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ation Application
iver installation order from Table 5 - 
 - 6 (the drivers must be installed 

r) which is the same as that listed in 
 the left.
 to select and run the driver you 
ll.
 of the drivers you have installed.
ter needs to restart after installing a 
ou will usually need to click the 
 button when prompted to restart 
r.
ou tick the “Show Install Menu 
u start Windows when CD is 

kbox to come back to the Driver 
creen (otherwise click Start (menu) 
 navigate (Browse..) to 
XE and click OK 

 the My Computer icon (for WinXP 
en double-click the CD icon).
Driver Installation
Insert the Device Drivers & Utilities + User’s Man-
ual CD-ROM and the Driver Installation applica-
tion will run automatically. You can double-click
the driver name on the left of the screen to begin the
install process. Alternatively you can browse to the
Drivers folder on the CD and select the appropriate
driver folder, then run the setup.exe.

Figure 5 - 2 - Driver Installation

Driver Install
1. Check the dr

1, on page 5
in this orde
the menu on

2. Double-click
wish to insta

3. Make a note
4. If the compu

driver, and y
“Yes/Finish”
the compute

5. Make sure y
next time yo
Inserted” tic
Installation s
> Run... and
D:\SETUP.E
OR 
Double-click
only), and th
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n XP (SP2) 

not included in your Windows version

, 8 - 8, 8 - 10, 8 - 12 & 8 - 13

s 8 - 15 & 8 - 17

pages 8 - 21
- 6 Driver Installation

Table 5 - 1 - Install Procedure

Feature Windows 2000 (SP4)/Wi

Service Pack Install the appropriate Service Pack for your system if 

Chipset Page 5 - 7

Audio Page 5 - 7

Video Page 5 - 8

Network (LAN) Page 5 - 8

Modem Page 5 - 9

Quick-Key Page 5 - 9

TouchPad Page 5 - 10

PCMCIA / Card Reader Page 5 - 10

Check Mail Page 5 - 11

Hot Key Page 5 - 11

Wireless LAN See the install procedure on pages 8 - 4, 8 - 6

Bluetooth See the install procedure on page

PC Camera See the install procedure on 
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2000/WinXP)
k Chipset from the Driver 
 menu. 

 (menu) > Run... and navigate 
to D:\Driv-
ate\infinst_autol.exe and click 

> Yes > Next.
h to restart the computer.

00/WinXP)
k Audio from the Driver Instal-
. 

 (menu) > Run... and navigate 
to D:\Drivers\Audio\Setup.exe 
K.
> Finish to restart the computer.
ck the AC97 Audio Configura-
 in the taskbar for configuration 
Driver Installation Procedure
This section covers driver and utility installation in-
structions for Windows 2000 Professional and Win-
dows XP Home & Professional.

New Hardware Found
If you see the message “New Hardware Found”
(Found New Hardware Wizard) during the in-
stallation procedure (other than when outlined in
the driver install procedure), click Cancel to close
the window, and follow the installation procedure
as directed.

Service Pack Installation
Make sure you install the appropriate service pack
for your operating system before installing any
drivers (see “Windows 2000 with Service Pack 4”
on page 5 - 3 and “Windows XP Service Pack 2”
on page 5 - 3).

Chipset (Win
1. Double-clic

Installation
OR 
Click Start
(Browse..) 
ers\inf_upd
OK.

2. Click Next 
3. Click Finis

Audio (Win20
1. Double-clic

lation menu
OR 
Click Start
(Browse..) 
and click O

2. Click Next 
3. You can cli

tion icon 
options.
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0/WinXP)
k Lan from the Driver Installa-

 (menu) > Run... and navigate 
to D:\Drivers\Lan\Setup.exe 
K.

h.
k settings can now be config-
- 8 Driver Installation

Video (Win2000/WinXP)
1. Double-click VGA from the Driver Installa-

tion menu. 
OR 
Click Start (menu) > Run... and navigate 
(Browse..) to D:\Drivers\VGA\Setup.exe 
and click OK.

2. Click Next > Yes.
3. Click Finish to restart the computer.
4. See “Advanced Video Controls” on page 3 - 

2 for details on adjusting the video settings.

LAN (Win200
1. Double-clic

tion menu. 
OR 
Click Start
(Browse..) 
and click O

2. Click Next.
3. Click Finis
4. The networ

ured.
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5
in2000/WinXP)

k Quick-Key from the Driver 
 menu. 

 (menu) > Run... and navigate 
to D:\Drivers\Quick-
001.exe and click OK.

 language you prefer, and click 

h to restart your computer.

em Country Selection

 if the modem country selection is ap-
u (Control Panel > Phone and Mo-
Modem (Win2000/WinXP)
1. Double-click Modem from the Driver 

Installation menu. 
OR

For Win2000
Click Start (menu) > Run... and navigate 
(Browse..) to D:\Driv-
ers\Modem\Win2K\Setup.exe and click 
OK.

For WinXP
Click Start (menu) > Run... and navigate 
(Browse..) to D:\Driv-
ers\Modem\WinXP\Setup.exe and click 
OK.

2. Click  (button).
3. Click .
4. The modem is ready for dial-up configura-

tion.

Quick-Key (W
1. Double-clic

Installation
OR 
Click Start
(Browse..) 
KEY\CNK

2. Choose the
OK.

3. Click Next.
4. Click Finis

Mod

Be sure to check
propriate for yo
dem Options).
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ard Reader (Win2000/

k PCMCIA CardReader from 
nstallation menu. 

 (menu) > Run... and navigate 
 to D:\Drivers\PCMCIA-Car-
tup.exe and click OK.

 language you prefer, and click 

> Finish.
- 10 Driver Installation

TouchPad (Win2000/WinXP)
1. Double-click TouchPad from the Driver 

Installation menu. 
OR 

For Win2000
Click Start (menu) > Run... and navigate 
(Browse..) to D:\Drivers\Touch-
pad\Win2K\Setup.exe and click OK.

For WinXP
Click Start (menu) > Run... and navigate 
(Browse..) to D:\Drivers\Touch-
pad\WinXP\Setup.exe and click OK.

2. Click Next > Next > Next.
3. Click Finish to restart your computer (Click 

Yes/Contiune Anyway if asked if you want 
to continue).

4. You may then configure your TouchPad as 
outlined in “TouchPad and Buttons/
Mouse” on page 2 - 13.

PCMCIA & C
WinXP)
1. Double-clic

the Driver I
OR 
Click Start
(Browse...)
dReader\se

2. Choose the
OK.

3. Click Next 
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5

2000/WinXP)
k HotKey from the Driver 
 menu. 

 (menu) > Run... and navigate 
to D:\Drivers\HotKey 
up.EXE and click OK.
> Install > Finish.
h to restart the computer.
details see “Hot Keys” on page 2 
Check Mail (Win2000/WinXP)
1. Double-click E-MAIL LED from the 

Driver Installation menu. 
OR 
Click Start (menu) > Run... and navigate 
(Browse..) to D:\Drivers\E-mail 
LED\Setup.exe and click OK. 

2. To continue click Next > Install > Finish.
3. Click Finish to restart the computer.
4. The program will run upon startup.
5. For further details see “” on page 2 - 9.

Hot Key (Win
1. Double-clic

Installation
OR 
Click Start
(Browse..) 
Driver\Set

2. Click Next 
3. Click Finis
4. For further 

- 8.
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Win2000/WinXP)
edure in “PC Camera Driver In-
000)” on page 8 - 21 or “PC Cam-
llation (WinXP)” on page 8 - 21.
- 12

Wireless LAN (Win2000/WinXP)
See the introduction in “Intel PRO/Wireless Mini-
PCI WLAN Module” on page 8 - 2, and check the
install procedure for your appropriate module and
operating system.

Bluetooth (Win2000/WinXP)
See install procedure in “Bluetooth Driver Instal-
lation (Win2000)” on page 8 - 15 or “Bluetooth
Driver Installation (WinXP)” on page 8 - 17.

PC Camera (
See install proc
stallation (Win2
era Driver Insta
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ystem)
omput-
chosen
OS in-
ration
CU al-

ure of
m, and
ve any

hanges
riginal
 of the
 useful

Settings Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes return to the
SCU, go to the Exit
menu and select the
Default Settings and
click OK.
Chapter 6: BIOS Utilities
Overview
This chapter is about the computer’s built-in software.

Your computer comes with built-in BIOS (Basic Input Output S
which is an essential set of software routines stored on a chip in your c
er. These routines serve to describe your computer’s hardware to your 
operating system, and provides an interface between the two. The BI
cludes the POST (Power On Self Test) and the SCU (System Configu
Utility). The POST performs diagnostic procedures at startup, the S
lows you to configure your computer.

There is one general rule: Don’t make any changes unless you are s
what you are doing. Many of the settings are required by the syste
changing them could cause it to become unstable or worse. If you ha
doubts, consult your service representative.

If your computer has never been set up, or you are making important c
to the system, then you should review this chapter first and note the o
settings found in the SCU. Even if you are a beginner, keep a record
settings you find and any changes you make. This information could be
if your system ever needs servicing.



BIOS Utilities

6

6

 (POST)
ystem takes a few seconds to con-
on-board RAM. As the POST pro-
 is anything wrong. If there is a
 booting, it will display a system

m Configuration Utility) prompt
 operating system. Once that starts,
ing the computer.

Rights Reserved

3

- 2 The Power-On Self Test (POST)

The Power-On Self Test
Each time you turn on the computer, the s
duct a POST, including a quick test of the 
ceeds, the computer will tell you if there
problem which prevents the system from
summary and prompt you to run SCU.

If there are no problems, the SCU (Syste
will disappear and the system will load the
you can’t get into the SCU without reboot

The POST Screen

1.CPU type
2.Memory status
3.Enter SCU prompt

appears only during
POST

Note: The POST
screen as pictured
above is for guideline
purposes only. The
POST screen on your
computer may appear
slightly different. If you
choose the Fast Boot
option you will see an
abbreviated version of
this screen.

Figure 6 - 1
POST Screen

Insyde Software MobilePro BIOS Version 1.01
Copyright 1983 - 2002 Insyde Software Corp. All

H8 VERSION 06.03.02

1500 MHz Celeron M with MMX CPU
CPU Microcode Update Rev 045h Complete
L2 Cache: 512K installed
32MB Video RAM
Insyde Software Plug-n-Play BIOS Ver 1.17.01

Base Memory 0000640 KB
Extended Memory 0490496 KB
Totak Memory 0491520 KB
Shared Memory 032768 KB

Auto Detecting IDE Devices[Done]

Press F2 to Enter System Configuration Utility

1

2
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tive or

tifying

he cor-

ou still
s even
The Po

Failing the POST
Errors can be detected during the POST. There are two categories, “fat
“non-fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something se
wrong with your system. Take the computer to your service representa
authorized service center as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message iden
the problem (make a note of this message!) followed by the prompt:

• Press <F1> to resume
• Press F2 to enter System Configuration Utility

Press F1 to see if the boot process can continue. It may work, without t
rect configuration.

Press F2 to run the SCU program and try to correct the problem. If y
get an error message after you change the setting, or if the “cure” seem
worse, call for help.
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on Utility
 configure itself and manage basic
ation and power management). The
 and written to the CMOS RAM.
 when the computer is turned off.

 press F2 when you see the prompt
tility”. The prompt seen in Figure
briefly after the system is powered
 because you pressed F2 too quick-

en hold down F2 when you see the
r.
- 4 The System Configuration Utility

The System Configurati
The SCU program tells the system how to
features and subsystems (e.g. port configur
settings are stored in a nonvolatile battery
This means that the settings are saved even

Entering Setup
To enter the SCU, turn on the computer and
“Press F2 to enter System Configuration U
6 - 1 on page 6 - 2 is usually present very 
on. If you get a “Keyboard Error” (usually
ly) just press F2 again.

If the computer is already on, reboot and th
prompt. The SCU’s main menu will appea

BIOS Settings V’s 
OS Settings

Though many options
such as power man-
agement and display
settings may be set in
the BIOS, these are
usually best set in your
OS (e.g. Windows).

Older OS’s such as
DOS etc. may still rely
entirely on the setup
information from the
BIOS. “Plug-n-Play”
OS’s, such as the vari-
ous Windows sys-
tems, may override
these settings with the
settings from the sys-
tem’s Control Panel. 



BIOS Utilities

rking with the Menu Bar 6 - 5

6

menus
ns:

r

ions

Table 6 - 1
SCU Menu 

Navigation Keys
Wo

Working with the Menu Bar
You can use the mouse to navigate around the various menus and sub
of the SCU, or alternatively, you can use the following key combinatio

Keys Action

Alt Activates the menu bar

Left arrow/Right arrow  → ←
Type the highlighted letters

Selects an option in the menu ba

Left mouse button
Down arrow ↓

Spacebar
Enter

Opens the pull-down menu bar opt

Right mouse button
Esc Cancels the action
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own Menu
hted, press Enter or left-click with
s. The following keys allow you to

Action

Changes the value

llows you to choose:
OK> to save changes
el to ignore any changes>
- 6 Working with the Pull-Down Menu

Working with the Pull-D
Once your desired menu bar item is highlig
the mouse to see the pull-down menu item
move about the pull-down menu:

Keys

Down/Up arrows (↓↑)

Enter
A
<

<Canc

Table 6 - 2
Pull-Down Menu 

Keys
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 which
 Enter
ing the

the 

nd 

SCU Screens

The screens which ap-
pear on the following
pages are intended as
a guideline.

It should be noted that
the screen on your par-
ticular computer may
appear a little different-
ly.

Table 6 - 3
Sub Menus

(Right Arrow 
Enabled)
W

Working with Sub-Menus
Some pull-down menu options have an arrow to the right of the entry
indicates a sub-menu is available. Choose these sub-menus by pressing
and the screen will be displayed. Navigate through these screens by us
keys in the table below:

Keys Action

Tab Moves from one field to another

Down/Up arrows (↓↑) Selects an item within the field

Spacebar Enables the specified function (a dot indicates 
function is enabled)

OK/Enter Accepts the entries and closes the sub-menu a
saves the changes

Cancel/Esc Rejects the entries and closes the sub-menu
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 test and other delays at power-up.

Nov 12, 2004 9:40:02 am

System

Memory

CPU Clock = 1700 MHz

Base = 640 KB
Extended =1014784 KB
Shadow = 64 KB
Reserved = 320 KB
Total RAM =1015808 KB
Cache (Ext) = 1024 KB
- 8 Startup Menu

Startup Menu

Fast Boot (Startup Menu)
Enable this option to eliminate the memory

Figure 6 - 2
Startup Menu

Insyde Software SCU For Intel chipset

Set system date and time

Floppy Drive A = 1.44MB
Hard Drive C = 20005MB
Hard Drive D = 0 MB
Hard Drive E = 0 MB
Hard Drive F = 0 MB
3IRQ 7
Serial Port 2

DevicesDate and Time �

√ Fast Boot
Boot Device �

Display �

√ Enable Battery Low Beep
√ Enable Power On Beep
√ Display OEM logo
√ Fast Boot for Windows XP

Boot Password �

SCU Password �

Startup Disks Components Power Exit
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system
e hard
disk in
 set the

puter’s
e “En-
sted by
ices in
Boot Device (Startup Menu)
Specify which device your computer should look on for an operating 
by priority. In most cases your computer “boots” (starts-up from) th
disk. There are cases where you may want to “Boot” from a floppy 
drive “A:” (use a USB floppy drive), or the CD device. You may also
computer to boot from the network (PXE LAN).

Display (Startup Menu)
Enables your choice of CRT (external VGA monitor), LCD (the com
display screen), or both. These settings are best changed in your OS (se
abling Other Displays” on page 3 - 7), and may also be quickly adju
means of the Fn and F7 keys. If you want to use multiple display dev
operating systems other than Windows, you may set the options here.

Enable Battery Low Beep (Startup Menu)
Enable or disable the low battery beep if the power is getting low.

Enable Power On Beep (Startup Menu)
Enable or disable the beep when the computer “boots up”.
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 display of the OEM logo (if appli-

 Menu)
ast system startup option if you are

 Menu)
mputer starts-up (Boot Password),
). See the sidebar for a warning on
- 10 Startup Menu

Display OEM logo (Startup Menu)
Enable or disable (enabled by default) the
cable) during the POST process.

Fast Boot for Windows XP (Startup
Enable or disable (enabled by default) the f
using the Windows XP OS.

Boot and SCU Passwords (Startup
You can set the passwords for when the co
and for access to the SCU (SCU password
setting the password.

Password Warning

If you choose to set a
boot password, NEV-
ER forget your pass-
word. 

The consequences of
this could be serious. If
you cannot remember
your boot password
you must contact your
vendor and you may
lose all of the informa-
tion on your hard disk.
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device.
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itten to
This is
s soft-

Figure 6 - 3
Disks Menu

(IDE Settings)
Disks Menu

IDE Settings (Disks Menu)
You can use this menu to set the options for your hard disk and CD 
Only make changes if you are sure of what you are doing.

Virus Alerts (Disks Menu)
Enable this option to receive a warning if the area of the hard disk con
information on how to start up the computer is having information wr
it. This can help warn you if viruses are attempting to affect this area. 
not a substitute for proper virus protection supplied by updated anti-viru
ware, merely an extra safeguard (see “Viruses” on page 9 - 4).

Insyde Software SCU For Intel chipset Nov 12, 2004 6:40:02 am

Press (Tab) key to select a control. <OK> button or <Enter> key accept
entries. <Cancel> button or <Esc> key rejects entries. Use cursor, spacebar,
and numeric keys to change values. <Alt> key activates acclerators.

System

Hard

MHz

KB
KB

KB
KB
KB

KB

Devi

Startup Disks Components Power Exit

�  OK �

DriD
_ Virus Alert

00M

640
854
64

320
888
512

Memory

CPU Cl ck = 100

Base = 6
Extended =1218
Shadow =
Reserved = 3
Total RAM =1228
Cache (Ext) = 5

Mive C = 20005M

M

4

8

i

�  OK �OK�  OK � Cancel

[X] Drive Enabled
[X] Multiple Sector Mode
[X] PIO Mode

[X] Drive Enabled
[X] PIO Mode

IDE UDMA-33/66/100 Function : Enable
IDE 32Bit I/O : Enable

IDE Settings �

Primary HDD Primary ATAPI

IDE Settings
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u to configure your printer (parallel

enu)
with Number Lock enabled.

Components Menu)
 and language from these menus.

Nov 12, 2004 6:40:02 am

nd IRQ assignment

System

Memory

CPU Clock = 1700 MHz

Base = 640 KB
Extended =1014784 KB
Shadow = 64 KB
Reserved = 320 KB
Total RAM =1015808 KB
Cache (Ext) = 1024 KB
- 12 Components Menu

Components Menu

LPT Port (Components Menu)
The options under this menu item allow yo
port).

Keyboard Numlock (Components M
Enable this mode to start the computer up 

Keyboard Repeat/Keyboard Type (
Change the keyboard repeat rate, key delay

Figure 6 - 4
Components Menu Insyde Software SCU For Intel chipset

Select parallel (printer) port I/O address a

Hard Drive C

Startup Disks Components Power Exit

Devices

= 20Keyboard Repeat

LPT Port �

_Keyboard Numlock ��
Keyboard Repeat �
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u)
 power
ings to
pply to
 Man-

Power Menu

The Power Menu al-
lows you to set power
saving options for sys-
tems other than Win-
dows. If you are using
a Windows OS, then
the power saving op-
tions are best set there
(see “Power Manage-
ment” on page 4 - 1).

Figure 6 - 5
Sub Menus

(Right Arrow 
Enabled)
Power Menu

Low/Medium/High/Customize Power Saving (Power Men
You may choose to set power saving options for Low, Medium or High
savings in this menu, or alternatively you may Customize the sett
change the time until the hard disk goes in to standby. These settings a
Non-Windows operating systems only (for Windows OS’s see “Power
agement” on page 4 - 1).

Insyde Software SCU For Intel chipset Nov 12, 2004 6:40:02 am

Set power saving to lowest settings.

Hard Drive C = 30007 M

Extended =1014784 KB
Shadow = 64 KB
Reserved = 320 KB
Total RAM =1015808 KB
Cache (Ext) = 1024 KB

Startup Disks Components Power Exit

Systemm

Memory

CPU Clock = 1400 M

MB

Hz

Base = 640 KB

M

_ Low Power Saving
_ Medium Power Saving
_ High Power Saving
√ Customize �

 CPU SpeedStep Controls �

√ Turn on power for bluetooth device
√ Turn on power for camera device
√ Turn on radio for wireless LAN device

Devices
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enu)
eedStep controls here (“Intel CPU
s full detail on the settings). Intel
e settings, however if you have a
ulated by CPU throttling and you
.

is option to give maximum avail-
t low.

ble this option to save maximum 
y battery.
 - Enable this option to have the 
ery or AC adapter, and change the 

mode setting will appear on screen
 to/from the DC-In Jack, after you
e 2 - 2, on page 2 - 9).

enu)
able/disable power to the optional
les) for extra power saving.
- 14 Power Menu

CPU SpeedStep Controls (Power M
You can set the mode for the Intel CPU Sp
SpeedStep Controls” on page B - 3 give
Pentium M processors fully support thes
Celeron M Processor the settings are em
may still set the options to your preference

• Performance Mode Always - Enable th
able performance when the battery is no

• Battery Optimized Mode Always - Ena
power when the computer is powered b

• Automatically Switch (Default Setting)
computer detect if it is powered by batt
setting accordingly.

Indicators displaying the CPU SpeedStep 
when you plug-in/remove the AC adapter
have installed the hot key driver (see Tabl

Turn on power/radio for ........ (Power M
Choose the options from this menu to en
modules (Bluetooth/Camera/WLAN modu

CPU SpeedStep 
Controls & CPU 

Performance

If you have a Pentium
M processor, the set-
tings for CPU Speed-
Step Controls will
have an affect on the
CPU’s speed and per-
formance (in order to
save power under cer-
tain conditions). See
“Intel CPU Speed-
Step Controls” on
page B - 3 for more
details on how the set-
tings control the CPU
speed and perfor-
mance. If you have a
Celeron M Processor
the settings are emu-
lated by CPU throttling.
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 made.

Figure 6 - 6
Exit Menu

2 am

B

B

Exit Menu

Save and Exit (Exit Menu)
This option allows you to exit the SCU and save the changes you have

Insyde Software For Intel chipset Nov 12, 2004 6:40:0

Save current settings and return to previous work

Memory

Hard Drive C = 30007 MB

= 1700 MHz

Base = 640 KB
Extended =1014784 K
Shadow = 64 KB
Reserved = 320 KB
Total RAM =1015808 K
Cache (Ext) = 1024 KB

Startup Disks Components Power Exit

Devices Systemm

CPU Clock

Save and Exit �

Exit (No Save) �

  �Default Settings �

Restore Settings �
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thout saving any changes made.

tings to the original defaults before

U settings to the last changes you
- 16 Exit Menu

Exit (No Save) - (Exit Menu)
This option allows you to exit the SCU wi

Default Settings (Exit Menu)
This option allows you to reset the SCU set
any changes were made to the system.

Restore Settings (Exit Menu)
This option will allow you to restore the SC
had made.
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ow the
r prob-
re you

n anti-
age the

rm it.

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.
Chapter 7: Upgrading The Com
Overview
This chapter contains information on upgrading the computer. Foll
steps outlined to make the desired upgrades. If you have any trouble o
lems you can contact your service representative for further help. Befo
begin you will need:

• A small crosshead or Phillips screwdriver
• A small regular slotted (flathead) screwdriver
• An antistatic wrist strap

Before working with the internal components you will need to wear a
static wrist strap to ground yourself because static electricity may dam
components.

The chapter includes:

• Removing the Battery
• Upgrading the Hard Disk(s)
• Upgrading the System Memory
• Upgrading the Optical (CD/DVD) Device(s)
Please make sure that you review each procedure before you perfo
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7

tem’s case, adding and sometimes

ades if:

 service contract
ent 

r service representative to purchase

rning

 the purposes of device upgrade, re-
before turning the computer on.
- 2 Overview

When Not to Upgrade
These procedures involve opening the sys
replacing parts.

You should not perform any of these upgr

• Your system is still under warranty or a
• You don’t have all the necessary equipm
• You’re not in the correct environment
• You doubt your abilities

Under any of these conditions, contact you
or replace the component(s).

Power Safety 
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines). It is
advisable to also re-
move your battery in
order to prevent acci-
dentally turning the
machine on.

Removal Wa

When removing any cover(s) and screw(s) for
member to replace the cover(s) and screw(s) 
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7

 safety

ated.

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

Figure 7 - 1
Battery Removal
Removing the Battery
If you are confident in undertaking upgrade procedures yourself, for
reasons it is best to remove the battery.
1. Turn the computer off, and turn it over.
2. Slide the latch  in the direction of the arrow.
3. The battery  will pop up to allow you to lift it out of the bay as indic

1
2

2

1
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k Drive(s)
accommodate other 2.5" IDE hard
 “Storage” on page C - 3). Follow
uctions, and install all necessary

s & Utilities” on page 5 - 1), when

nd remove the battery.
 and remove screws  - .1 4

5

- 4 Upgrading the Hard Disk Drive(s)

Upgrading the Hard Dis
The hard disk drive(s) can be taken out to 
disk drives with a height of 9.5mm (h) (see
your operating system’s installation instr
drivers and utilities (as outlined in“Driver
setting up a new hard disk.
1. Turn off the computer, and turn it over a
2. Locate the hard disk/memory bay cover
3. Remove the bay cover .

HDD System 
Warning

New HDD’s are blank.
Before you begin make
sure:
You have backed up any
data you want to keep
from your old HDD.
You have all the CD-
ROMs and FDDs re-
quired to install your oper-
ating system and
programs.
If you have access to the
internet, download the lat-
est application and hard-
ware driver updates for
the operating system you
plan to install. Copy these
to a removable medium.

5

Figure 7 - 2
HDD/RAM Bay 
Cover Removal

34

21



Upgrading The Computer

g the Hard Disk Drive(s) 7 - 5

7

 disk 

embly 

Figure 7 - 3
HDD Assembly 

Removal
10

12
Upgradin

4. Pull the tab  in the direction of the arrow  in order to release the
assembly form the connector.

5. Lift the hard disk assembly  up out off the computer.
6. Remove screws from points  -  on the side of the hard disk ass

in order to separate the bracket from the hard disk .
7. Reverse the process to install a new hard disk(s).

6 7

8
9 12

13

7
8

9

11

13

6
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emory (RAM)
 200 pin Small Outline Dual In-line
 (see “Memory” on page C - 2 for

al memory size is automatically de-
on your computer. 
nd remove the battery.
 and remove screws  - .1 4

5

- 6 Upgrading the System Memory (RAM)

Upgrading the System M
The computer has two memory sockets for
(SO-DIMM) - DDR type memory modules
details of supported module types). The tot
tected by the POST routine once you turn 
1. Turn off the computer, and turn it over a
2. Locate the hard disk/memory bay cover
3. Remove the bay cover .

Supported RAM 
Module Types

Use ONLY the DDR
RAM module types in-
dicated in “Memory”
on page C - 2.

Figure 7 - 4
HDD/RAM Bay 
Cover Removal

5

34

21
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7

mory 

ctors 

 the 
e 

vers 

4).
 

Contact Warning

Be careful not to touch
the metal pins on the
module’s connecting
edge. Even the clean-
est hands have oils
which can attract parti-
cles, and degrade the
module’s perfor-
mance.

Figure 7 - 5
RAM Module 

Removal
Upgrading the

4. Gently pull the two release latches (  & ) on the sides of the me
socket in the direction indicated by the arrows in Figure 7 - 5.

5. The RAM module  will pop-up, and you can remove it.
6. Pull the latches to release the second module if necessary.
7. Insert a new module holding it at about a 30° angle and fit the conne

firmly into the memory slot.
8. The module’s pin alignment will allow it to only fit one way. Make sure

module is seated as far into the slot as it will go. DO NOT FORCE th
module; it should fit without much pressure.

9. Press the module in and down towards the mainboard until the slot le
click into place to secure the module.

10. Replace the memory socket cover and the 4 screws (see Figure 7 - 
11. Restart the computer to allow the BIOS will register the new memory

configuration as it starts up.

6 7

76

76

8

8

8



Upgrading The Computer

7

7

D/DVD) Device(s)
nd remove the battery.
 and remove screws  - .

optical device  out of the 

1 5

7

6

- 8 Upgrading the Optical (CD/DVD) Device(s)

Upgrading the Optical (C
1. Turn off the computer, and turn it over a
2. Locate the hard disk/memory bay cover
3. Remove the bay cover .
4. Use a screwdriver to carefully push the 

computer at point .

Figure 7 - 6
Removing the CD/

DVD Device(s)

6

8

34

21

5

87
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or with
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 incor-

Warranty

The CPU is not a user
serviceable part.
Opening this compart-
ment, or accessing the
CPU in any way, may
violate your warranty.

Unauthorized tamper-
ing with the HDD may
also violate your war-
ranty.
U

Upgrading the Processor
If you want to upgrade your computer by replacing the existing process
a faster/new one you will need to contact your customer service repr
tive. We recommend that you do not do this yourself, since if it is done
rectly you may damage the processor or mainboard.
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8

nd PC
on the
 repre-

G 
Chapter 8: Modules
Overview
This chapter contains the information on the WLAN, Bluetooth, a
Camera modules which may come with your computer, depending 
configuration purchased. If you are unsure please contact your service
sentative.

The chapter includes information on the following:

• Intel PRO/Wireless 2100 (802.11b)/ 2200BG (802.11b/g)/ 2195AB
(802.11a/b/g) Mini PCI WLAN Module

• The Bluetooth Module
• The PC Camera
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8

-PCI WLAN Module
2.11b), 2200BG (802.11b/g) or

N module is supplied as a standard
 appropriate software CD provided

100, 2200BG or 2195ABG Mini-
ireless LAN module is on (the 
Key (see “Quick-Key Buttons” on
 LAN module (make sure you in-
 Table 5 - 1, on page 5 - 6). If you
r status of the WLAN module will
2 - 8).
- 2 Intel PRO/Wireless Mini-PCI WLAN Module

Intel PRO/Wireless Mini
Either an Intel PRO/Wireless 2100 (80
2195ABG (802.11a/b/g) Mini-PCI WLA
feature for the computer. You will have the
for your module.

Before installing the Intel PRO/Wireless 2
PCI WLAN driver, make sure that the W
LED will be green). Use the WLAN Quick-
page 1 - 7) to toggle power to the Wireless
stall the drivers in the order indicated in
have installed the Hot Key driver the powe
appear on screen (see “Hot Keys” on page

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission
devices aboard aircraft is
usually prohibited. Make
sure the module(s) are
OFF if you are using the
computer aboard aircraft.

If you restart/shut down
the computer the power
status of the module will
remain the same as it
was before the restart/
shut down.
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8

om the

BG 
 

Figure 8 - 1
Installation 

Screens
Intel PRO/Wireless

To get help on the network settings you can view the User Guides fr
Intel PRO CD-ROM.

For Intel PRO Wireless 2100 

For Intel PRO Wireless 2200BG 
For Intel PRO Wireless 2195A

1

& Intel PRO Wireless 2200BG
2

3
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river Installation 

the CD drive.
on).

 and click Next > Next > Install 

s and click Control Panel. Dou-
k Hardware (tab) > Device 

ick “+” next to Other Devices (if 

nd click the Reinstall Driver 

ard appears, click Next (make 
for a suitable driver for my 
Next.
elect ONLY “Specify a loca-

0\PROW7100\WIN2K.
- 4 Intel PRO/Wireless Mini-PCI WLAN Module

Intel PRO/Wireless 2100 WLAN D
(Win2000)
1. Insert the Intel PRO CD-ROM into 
2. Click Wireless LAN Adapters (butt
3. Click Install Software (button).
4. Click Next.
5. Click the button to accept the license

> Finish.
6. Click Start (menu), point to Setting

ble-click System (icon) and then clic
Manager (button).

7. Click Device Manager (tab), then cl
its sub-items are not shown).

8. Double-click Network Controller, a
(button).

9. When the Update Device Driver Wiz
sure that you have selected “Search 
device (recommended)”) and click 

10. When Locate Driver Files appears, s
tion” and click Next.

11. Navigate (Browse...) to D:\ProW210
12. Click Open > OK > Next.
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ork 

nstall 

point-
icking 
ss 

 click-
 as per

Windows 2000 
Internet Explorer 

5.5

Make sure that you in-
stall Internet Explorer
5.5 (or higher ver-
sion) if you are using
the Windows 2000
OS.
Intel PRO/Wireless

13. Input your network name and click Next, then select your netw
settings and click Next.

14. Click Finish and close the open windows.

You can now install the Administration Tools.
1. Insert the Intel PRO CD-ROM into the CD drive.
2. Click Wireless LAN Adapters (button).
3. Click Install Administration Tools (button).
4. Click Next.
5. Click the button to accept the license and click Next > Next > I

> Finish.
6. You can configure the settings by going to the Start menu and 

ing to Programs and clicking Intel Network Adapters, then cl
either the Intel (R) PROset icon, or the options under the Acce
Point Administration Tools.

You can view the User Guides by inserting the Intel PRO CD-ROM and
ing Wireless LAN Adapters (button) > View User Guides (button)
“Installation Screens” on page 8 - 3.
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river Installation 

the CD drive.
on).

 and click Next > Next > Install 

n on your desktop (if you cannot 
p 7) click on it once to select it, 
enu appear and scroll down to 
 8).

 icon click Start (menu), then 
t it) My Computer. Right-click 
scroll down to Properties and 

 Device Manager (button).
its sub-items are not shown).
nd click Reinstall Driver (but-

appears select “No, not this 
- 6 Intel PRO/Wireless Mini-PCI WLAN Module

Intel PRO/Wireless 2100 WLAN D
(WinXP)
1. Insert the Intel PRO CD-ROM into 
2. Click Wireless LAN Adapters (butt
3. Click Install Software (button).
4. Click Next.
5. Click the button to accept the license

> Finish.
6. If you can see the My Computer ico

see the My Computer icon go to ste
then right-click it to make the sub-m
Properties and click on it (go to step

7. If you cannot see the My Computer
point to (but don’t click just highligh
it to make the sub-menu appear and 
click on it (go to step 3).

8. Click the Hardware (tab), then click
9. Click “+” next to Other Devices (if 
10. Double-click Network Controller a

ton). 
11. When the Hardware Update Wizard 

time” and click Next.
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lect 

nd 

nstall 

point-
dapt-
ns 

 click-
 as per
Intel PRO/Wireless

12. Click “Install from a list or specific location (Advanced)” th
click Next.

13. Select “Search for the best driver in these locations.” and se
ONLY “Include this location in the search:”.

14. Navigate (Browse...) to D:\ProW2100\PROW7100\WINXP a
click OK > Next.

15. Click Finish and close the open windows.

You can now install the Administration Tools.

1. Insert the Intel PRO CD-ROM into the CD drive.
2. Click Wireless LAN Adapters (button).
3. Click Install Administration Tools (button).
4. Click Next.
5. Click the button to accept the license and click Next > Next > I

> Finish.
6. You can configure the settings by going to the Start menu and 

ing to Programs/All Programs and clicking Intel Network A
ers, then clicking either the Intel (R) PROset icon, or the optio
under the Access Point Administration Tools.

You can view the User Guides by inserting the Intel PRO CD-ROM and
ing Wireless LAN Adapters (button) > View User Guides (button)
“Installation Screens” on page 8 - 3.



Modules

8

8

 Driver Installation 

, then insert the Intel PRO CD-

mine which driver to install.

 and click Next > Next > Install 

s and click Control Panel.

nager (button).
ts sub-items are not shown).
nd click Reinstall Driver (but-

izard appears, click Next > Next 
earch for a suitable driver for 

elect ONLY “Specify a loca-

200\WIN2K.

dows.
- 8 Intel PRO/Wireless Mini-PCI WLAN Module

Intel PRO/Wireless 2200BG WLAN
(Win2000)
1. Make sure the module is powered on

ROM into the CD drive.
2. See the sidebar note in order to deter
3. Click Install Software (button).
4. Click Next.
5. Click the button to accept the license

> Finish.
6. Click Start (menu), point to Setting
7. Double-click System (icon). 
8. Click Hardware (tab) > Device Ma
9. Click “+” next to Other devices (if i
10. Double-click Network Controller, a

ton).
11. When the Upgrade Device Driver W

(make sure that you have selected “S
my device (recommended)”).

12. When Locate Driver Files appears, s
tion” and click Next.

13. Navigate (Browse...) to D:\PROW2
14. Click Open > OK > Next.
15. Click Finish and close the open win

Which Driver?

Note that there are two
driver installation op-
tions for the Intel Pro/
Wireless 2200BG Mini-
PCI WLAN module. If
the installation screen
which appears is the
same as  in Figure
8 - 1 on page 8 - 3 then
follow the procedure
listed on these pages.
If the installation
screen which appears
is the same as  in
Figure 8 - 1 on page 8
- 3 then follow the pro-
cedure listed on page
8 - 12.

2

3
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8

t for 
apt-

 click-
8 - 3.

Windows 2000 
Internet Explorer 

5.5

Make sure that you in-
stall Internet Explorer
5.5 (or higher ver-
sion) if you are using
the Windows 2000
OS.
Intel PRO/Wireless

16. You can configure the settings by going to the Intel (R) PROse
Wireless control panel (Start > Programs > Intel Network Ad
ers).

You can view the User Guides by inserting the Intel PRO CD-ROM and
ing View User Guides (button) as per “Installation Screens” on page
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 Driver Installation 

, then insert the Intel PRO CD-

mine which driver to install.

 and click Next > Next > Install 

n on your desktop (if you cannot 
p 6) click on it once to select it, 
enu appear and scroll down to 
 7).

 icon click Start (menu), then 
t it) My Computer. Right-click 
scroll down to Properties and 

 Device Manager (button).
its sub-items are not shown).
nd click Reinstall Driver (but-

appears select “No, not this 
- 10 Intel PRO/Wireless Mini-PCI WLAN Module

Intel PRO/Wireless 2200BG WLAN
(WinXP)
1. Make sure the module is powered on

ROM into the CD drive.
2. See the sidebar note in order to deter
3. Click Install Software (button).
4. Click Next.
5. Click the button to accept the license

> Finish.
6. If you can see the My Computer ico

see the My Computer icon go to ste
then right-click it to make the sub-m
Properties and click on it (go to step

7. If you cannot see the My Computer
point to (but don’t click just highligh
it to make the sub-menu appear and 
click on it (go to step 7).

8. Click the Hardware (tab), then click
9. Click “+” next to Other Devices (if 
10. Double-click Network Controller a

ton).
11. When the Hardware Update Wizard 

time” and click Next.

Which Driver?

Note that there are two
driver installation op-
tions for the Intel Pro/
Wireless 2200BG Mini-
PCI WLAN module. If
the installation screen
which appears is the
same as  in Figure
8 - 1 on page 8 - 3 then
follow the procedure
listed on these pages.
If the installation
screen which appears
is the same as  in
Figure 8 - 1 on page 8
- 3 then follow the pro-
cedure listed on page
8 - 13.

2

3
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 click-
8 - 3.
Intel PRO/Wireless 

12. Click “Install from a list or specific location (Advanced)” th
click Next.

13. Select “Search for the best driver in these locations.” and se
ONLY “Include this location in the search:”.

14. Navigate (Browse...) to D:\PROW2200\WINXP and click OK
Next.

15. Click Finish.
16. An Intel Configuration Service control panel will appear, and

can choose Yes to have Intel PROset software to manage the w
adapter.

17. A list of available networks will appear (click Finish to exit the
ard).

18. You can configure the settings by going to the Intel (R) PROse
Wireless control panel (Start > Programs/All Programs > Int
Network Adapters).

You can view the User Guides by inserting the Intel PRO CD-ROM and
ing View User Guides (button) as per “Installation Screens” on page
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N Driver Installation 

, then insert the Intel PROSet/ 
e.

 and click Next > Next > OK.
ter.
ing to the Intel (R) PROSet 
rams > Intel PROSet Wire-

e taskbar.

g the Intel PROSet/ Wireless CD-
tton) as per “Installation Screens”
- 12 Intel PRO/Wireless Mini-PCI WLAN Module

Intel PRO/Wireless 2195ABG WLA
(Win2000)
1. Make sure the module is powered on

Wireless CD-ROM into the CD driv
2. Click Install Software (button).
3. Click the button to accept the license
4. Click OK > Yes to restart the compu
5. You can configure the settings by go

Wireless control panel (Start > Prog
less), or by clicking the icon  in th

You can view the User Guides by insertin
ROM and clicking View User Guides (bu
on page 8 - 3.

Windows 2000 
Internet Explorer 

5.5

Make sure that you in-
stall Internet Explorer
5.5 (or higher ver-
sion) if you are using
the Windows 2000
OS.



Modules

Mini-PCI WLAN Module 8 - 13

8

Set/ 

K.

et 
re-

ss CD-
reens”
Intel PRO/Wireless 

Intel PRO/Wireless 2195ABG WLAN Driver Installation 
(WinXP)
1. Make sure the module is powered on, then insert the Intel PRO

Wireless CD-ROM into the CD drive.
2. Click Install Software (button).
3. Click the button to accept the license and click Next > Next > O
4. Click OK to complete the installation.
5. You can configure the settings by going to the Intel (R) PROS

Wireless control panel (Start > Programs > Intel PROSet Wi
less), or by clicking the icon  in the taskbar.

You can view the User Guides by inserting the Intel PROSet/ Wirele
ROM and clicking View User Guides (button) as per “Installation Sc
on page 8 - 3.
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e sure that the optional Bluetooth
Use the Bluetooth Quick-Key (see
gle power to the Bluetooth module
rs, click Cancel). Make sure you

in Table 5 - 1, on page 5 - 6. If you
er status of the Bluetooth module

page 2 - 8).

n the Bluetooth CD-ROM in the
-ROM and click Browse this CD).
nstall the program to read the file.
- 14 Bluetooth Module

Bluetooth Module
Before installing the Bluetooth driver, mak
module is on (the  LED will be green). 
“Quick-Key Buttons” on page 1 - 7) to tog
(if the Found New Hardware Wizard appea
install the drivers in the order indicated 
have installed the Hot Key driver the pow
will appear on screen (see “Hot Keys” on 

Manual
The Bluetooth Manual (readme.pdf) is o
Userguide folder (insert the Bluetooth CD
Click Acrobat Reader from the menu to i

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission
devices aboard aircraft is
usually prohibited. Make
sure the module(s) are
OFF if you are using the
computer aboard aircraft.
 
If you restart/shut down
the computer the power
status of the module will
remain the same as it
was before the restart/
shut down.
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t.

pears).

 con-
Panel 
Bluetooth Driver Installation (Win2000)
1. Insert the Bluetooth CD-ROM into the CD drive.
2. The program will run automatically.
3. If the Found New Hardware Wizard appears, click Cancel.
4. Click Install Drivers and Application Software and click Nex
5. Click the button to accept the license agreement, then click Nex
6. Click Next > Install (click OK if a Driver Signature Notice ap
7. Click Finish > Yes to restart the computer.
8. You can configure the settings in the Bluetooth Configuration

trol panel (Start menu and point to Settings and click Control 
then double-click the Bluetooth Configuration icon).
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0)
dows 2000 you may no longer hear
 taskbar. If this is the case then fol-

ol Panel (Start Menu and point to 
ouble-click the Sounds & Multime-

cording menus choose Realtek 

at the tickbox to “Show volume 
- 16 Bluetooth Module

Bluetooth Driver Audio Setup (Win200
After installing the Bluetooth driver in Win
any sound, nor see the Volume icon in the
low this procedure:

1. Go to the Sounds & Multimedia Contr
Settings and click Control Panel then d
dia icon).

2. Click the Audio tab.
3. In the Sound Playback and Sound Re

AC97 Audio.
4. Click the Sounds tab and make sure th

control on the taskbar” is ticked.
5. Click OK.
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8

t.
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ou 

 is not 
uc-
). 

own).
er.

 a 

lick 

xt.

 con-
Panel 

Bluetooth Support 
in Windows XP 
Service Pack 2

Windows XP Service
Pack 2 includes sup-
port for Bluetooth de-
vices, once the device
is enabled.

By installing the driver
you will get additional
application support for
your Bluetooth device.
Bluetooth Driver Installation (WinXP)
1. Insert the Bluetooth CD-ROM into the CD drive.
2. The program will run automatically.
3. Click Install Drivers and Application Software and click Nex
4. Click the button to accept the license agreement, then click Nex
5. Click Next > Install (click OK/Continue Anyway if asked if y

want to continue).
6. Click Finish.
7. The System Properties window should be open (if the window

open see “Windows XP Service Pack 2” on page 4 - 4 for instr
tions); click Device Manager (button) from the Hardware (tab

8. Click “+” next to Bluetooth Radios (if its sub-items are not sh
9. Right-click Generic Bluetooth Radio and select Update Driv
10. Select “No, not this time” and click Next.
11. When the Hardware Update Wizard appears, click “Install from

list or specific location (Advanced)” then click Next.
12. Click “don’t search. I will choose the driver to install.” and c

Next.
13. Click to select Billionton USB Bluetooth Device, and click Ne
14. Click Finish and close the open windows.
15. You can configure the settings in the Bluetooth Configuration

trol panel (Start menu and point to Settings and click Control 
then double-click the Bluetooth Configuration icon).
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el options after installing the Blue-

gs (or just click Control Panel) and 
e Sounds & Audio Devices/

View > Speech, and Audio 

e “Default device:” is Realtek 

ll Programs, then point to Acces-
minal.
e sure you have selected “Connect 
.

gs (or just click Control Panel) and 
e Printers and Faxes icon (Cate-
are).

e Fax Console.
 “Configure Fax...”.
e fax device is the Smart Link 56K 
- 18 Bluetooth Module

Bluetooth Control Panel Options
You may need to change some control pan
tooth driver:

Audio
1. Go to the Start menu and point to Settin

click Control Panel, then double-click th
Sounds & Multimedia icon (Category 
Devices).

2. Click Audio (tab) and make sure that th
AC97 Audio.

Hyper Terminal
1. Go to Start menu and click Programs/A

sories > Communications > HyperTer
2. Double-Click your connection, and mak

Using:” Smart Link 56K Voice Modem

FAX (WinXP)
1. Go to the Start menu and point to Settin

click Control Panel, then double-click th
gory View > Printers and Other Hardw

2. Double-click your fax icon to bring up th
3. Click the Tools menu and scroll down to
4. Click Next > Next and make sure that th

Voice Modem.
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8

 then 

 with 

ve it to 
FAX (Win2000)
1. Go to the Start menu and point to Settings and click Control Panel,

double-click the Fax icon.
2. Click Advanced Options (tab) and click the Open Fax Service 

Management Console (button).
3. Click Devices in the Tree window on the left.
4. The fax devices will be displayed in the right window, with the device

the highest priority displayed at the top.
5. Select the Smart Link 56K Voice Modem and use the arrows to mo

the top of the priority list, then close the windows.
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era you will need to install the de-
ing pages (make sure you install
le 5 - 1, on page 5 - 6). Before in-
the optional Camera module is on

era Quick-Key (see “Quick-Key
to the PC Camera module. If you
r status of the PC Camera module

page 2 - 8).

pplication software by going to the
rograms/All Programs menu and

er Information

nying insert pages, for the latest up-
 which may override the information
- 20 PC Camera

PC Camera
If you have purchased the optional PC Cam
vice driver for it as indicated on the follow
the drivers in the order indicated in Tab
stalling the Camera driver, make sure that 
(the  LED will be green). Use the Cam
Buttons” on page 1 - 7) to toggle power 
have installed the Hot Key driver the powe
will appear on screen (see “Hot Keys” on 

After installing the driver you can run the a
CMM PC Camera item in the Start > P
selecting the AMCAP program.

Taking Still 
Pictures

You may take still pic-
tures in the Windows
XP operating system
only.

Double-click the My
Computer icon on the
desktop, or go the
Start menu and point
to My Computer, then
click it.

.Double-click the CMM
PC Camera icon.

 

Click Take a new pic-
ture in the Camera
Tasks box.

Latest PC Camera Driv

Check the PC Camera CD, and any accompa
dated information on the PC Camera driver,
provided here.
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8

e).

click 

 the 

 the 
PC Camera Driver Installation (Win2000)
1. Insert the PC Camera CD-ROM into the drive.
2. Click Next (click Yes if asked if you want to continue at any tim
3. Click Finish to restart the computer.
4. After restart the computer will find the new hardware for you (

Yes if asked if you want to continue at any time).
5. Run the AMCAP program from the CMM PC Camera item in

Start > Programs/All Programs menu.

PC Camera Driver Installation (WinXP)
1. Insert the PC Camera CD-ROM into the drive.
2. Click Next.
3. Click Finish to restart the computer.
4. After restart the computer will find the new hardware for you.
5. Run the AMCAP program from the CMM PC Camera item in

Start > Programs/All Programs menu.
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our camera, it is necessary to setup

gs (or just click Control Panel) and 
e Sounds & Audio Devices icon 

ory View).
tab.
oll down and click Properties.
d click Microphone (check box), 

 Recording Control panel, under 
ost the volume as high as it will go).

gs and click Control Panel then 
ia icon.
ton) in the Sound Recording menu.
tions menu.
 Microphone section is checked, 
o.
- 22 PC Camera

PC Camera Audio Setup
If you wish to capture video & audio with y
the audio recording options in Windows.

(WinXP)
1. Go to the Start menu and point to Settin

click Control Panel, then double-click th
(Speech, and Audio Devices in Categ

2. Click Advanced in the Device volume 
3. Click Options (Volume Control) and scr
4. Click Recording (Adjust volume for) an

then click OK.
5. Make sure the Select (check box) in the

the Microphone section, is checked (bo
6. Close the window, then click OK.

(Win2000)
1. Go to the Start menu and point to Settin

double-click the Sounds and Multimed
2. Click Audio (tab) and click Volume (but
3. Select Advanced Controls from the Op
4. Make sure the Select (check box) in the

and boost the volume as high as it will g
5. Close the windows.
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Figure 8 - 2
Audio Setup 

(Windows XP)
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al purpose video viewing and test-
at.

 > Programs/All Programs > CMM 
hat you set the capture file before 
File below).
 wish to capture audio make sure 

) and select Start Capture.
ve not set the captured file) you will 
 (see the sidebar - Pre-Allocating 
tart Capture again.
d press Esc to stop the capture.
enu and select Save Captured 
tion, then click Open (you can view 

er).

d to set the capture file name on the
 program the next time the file will
ly captured file. To avoid overwrit-
e.. option in the File menu, and set
et the name and location then click
e file size if prompted).
- 24 PC Camera

AMCAP
AMCAP is a video viewer useful for gener
ing, and can capture video files to .avi form
 

1. Run the AMCAP program from the Start
PC Camera menu (it is recommended t
the capture process - see Set Capture 

2. Go to the Capture menu heading (if you
that the Capture Audio option is ticked

3. On the first run of the program (if you ha
be asked to choose a file name and size
File Space) for the captured file. Click S

4. Click OK to start capturing the video, an
5. If you wish to, you may go to the File m

Video As..., choose a file name and loca
the file using the Windows Media Play

Set Capture File
In AMCAP program you will only be aske
first run of the program. When you run the
automatically be overwritten with the new
ing files you can go to the Set Capture Fil
the file name and location before capture. S
Open (you can choose Cancel to ignore th

Pre-Allocating File 
Space

You may pre-allocate
the file size for the cap-
ture file in the AMCAP
program. You can
choose to ignore this
by clicking Cancel.

Pre-allocating space
on the hard disk can
improve the capture
quality (particularly of
large capture files), by
reducing the amount of
work the hard disk has
to do in finding space
for the video data as it
is being captured.

You may find it helpful
to defragment the HDD
before capture.
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ou can

 CMM 

Figure 8 - 3
Camera Controls
Eliminating Screen Flicker
If you find that the video screen in the AMCAP program is flickering, y
try to adjust the option from the Video Capture Filter options.
1. Run the AMCAP program from the Start > Programs/All Programs >

PC Camera menu.
2. Go to Options and scroll down to select “Video Capture Filter...”.
3. You can choose either 50Hz or 60Hz from the No Flicker box.
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Troubleshooting

Overview 9 - 1

9

g your service representative, you
mmon problems and their possible
ere before you panic. If you don’t
uctions carefully and observed the
resentative. You should also make

nient time possible, so you should
he system still won’t cooperate, try
nsaved data, but it may start work-
Chapter 9: Troubleshooting
Overview
Should you have any problems with your computer, before consultin
may want to try to solve the problem yourself. This chapter lists some co
solutions. This can’t anticipate every problem, but you should check h
find the answer in these pages, make sure you have followed the instr
safety precautions in the preface. If all else fails, talk to your service rep
a record of what happened and what remedies you tried.

Of course, if something goes wrong, it will happen at the most inconve
preview this section just in case. If, after you’ve tried everything, and t
turning it off for a few minutes and then rebooting. You will lose any u
ing again. Then call your service representative.
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9

 to a problem when your computer

outlet? If plugged into a power 
cators (see “LED Indicators” on 

oose connections anywhere.

Standby mode by pressing the 
Configuring the Power Button” 
ake-up the system.

 + F8 and F9 keys to adjust the 

to “external only” display (see 

 drive when you start up your 
isk - Replace the disk, and then 
estart”).
- 2 Basic Hints and Tips

Basic Hints and Tips
Many of the following may seem obvious but they are often the solution
appears not to be working. 

• Power - Is the computer actually plugged into a working electrical 
strip, make sure it is actually working. Check the LED Power Indi
page 1 - 6) to see the computer’s power status.

• Connections - Check all the cables to make sure that there are no l

• Power Savings - Make sure that the system is not in Hibernate or 
keys configured in your Power Management/Power Options (see “
on page 4 - 8), the Fn + Esc key combination, or power button to w

• Brightness - Check the brightness of the screen by pressing the Fn
brightness (see “Advanced Video Controls” on page 3 - 2).

• Display Choice - Press Fn + F7 to make sure the system is not set 
“Switching/Enabling Displays (Keyboard)” on page 3 - 9).

• Boot Drive - Make sure there are no floppy disks in any connected
machine (this is a common cause of the message “Invalid system d
press any key” / “Remove disks or other media. Press any key to r
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nd General Maintenance 9 - 3

9

nd programs safe, but close to 
m out of their original cases, e.g. 

 you can. You may schedule these 
u can use those that are provided 
 do so.

mputer). This is especially impor-
p Menu” on page 6 - 8).

mail settings etc. (even if just brief 

ing the CPU in any way, may violate
Backup a

Backup and General Maintenance
• Always backup your important data, and keep copies of your OS a

hand. Don’t forget to note the serial numbers if you are storing the
in a CD wallet.

• Run maintenance programs on your hard disk and OS as often as
programs to run at times when you are not using your computer. Yo
free with your OS, or buy the more powerful dedicated programs to

• Write down your passwords and keep them safe (away from your co
tant if you choose to use a Boot password for the SCU (see “Startu

• Keep copies of vital settings files such as network, dialup settings, 
notes).

Warranty
The CPU is not a user serviceable part. Opening this compartment, or access
your warranty.
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9

e which tells your program which 
d daily, and some of them may 
us programs are commercially 
e directly from the internet.

ses are often triggered from 
 file. You can configure most 

should also beware of files from 
nd been automatically forwarded 

ovides basic information which 
 OS’s documentation for instruc-
o provide such a disk (or at least 
- 4 Viruses

Viruses
• Install an Anti-Virus program and keep the definitions file (the fil

viruses to look for) up to date. New computer viruses are discovere
seriously harm your computer and cause you to lose data. Anti-Vir
available and the definitions file updates are usually downloadabl

• Be careful when opening e-mail from sources you don’t know. Viru
within e-mail attachments so take care when opening any attached
Anti-Virus programs to check all e-mail attachments. Note: You 
people you know as the virus may have infected an address book a
without the person’s knowledge.

• Keep a “Boot Floppy Disk” or “Bootable CD-ROM” (this disk pr
allows you to startup your computer) handy. You may refer to your
tions on how to make one, and many Anti-Virus programs will als
instructions on how to make one).
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9

oftware
less you are very sure of what you 

 if you are not comfortable with 

is that you are looking at the com-
e just purchased? Many problems 
ays refer to the documentation of 

iles entitled “READ ME” or 

ed on, and in many cases you will 
rrectly connected.

 have installed (latest driver files 
Upgrading and Adding 

Upgrading and Adding New Hardware/S
• Do not be tempted to make changes to your Windows Registry un

are doing, otherwise you will risk severely damaging your system.

• Don’t open your computer or undertake any repair or upgrade work
what you are doing.

• Read the documentation. We can assume, since you are reading th
puter’s manual, but what about any new peripheral devices you hav
are caused by the installation of new hardware and/or software. Alw
any new hardware and/or software, and pay particular attention to f
“READ ME FIRST”.

• When installing a new device always make sure the device is power
need to restart the computer. Always check that all the cables are co

• Make sure you have installed the drivers for any new hardware you
are usually available to download from vendor’s websites).
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 these changes may affect one or 
k and undo the change you just 

e easier the source of the problem 
ed into its ports, and a number of 

 a problem. Try disconnecting all 
vices unplugged. A process of 
essary) will often find the source 
- 6 Upgrading and Adding New Hardware/Software

• Thoroughly check any recent changes you made to your system as
more system components, or software programs. If possible, go bac
made and see if the problem still occurs.

• Don’t over complicate things. The less you have to deal with then th
may be found; Example - if your computer has many devices plugg
programs running, then it will be difficult to determine the cause of
of the devices and restarting the computer with all the peripheral de
elimination (adding and removing devices and restarting where nec
of a problem, although this may be time consuming.
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olution

battery bay, make sure the battery is
ttery only allows it to go in one way).

ry contacts.

omputer doesn’t start up immediately,

 has a Power Options scheme (see
gs. You may also be using a PC Card

eing recharged. Make sure the battery
re reusing (see “Battery Information”

trol Panel in Windows and re-enable

of power. Turn off the unused device to
Power

Problem Possible Cause - S

You turned on the power
but it doesn’t work.

Battery missing / incorrectly installed. Check the 
present and seated properly (the design of the ba
Make sure there’s nothing interfering with the batte

The Battery LED power
indicator , is blinking
orange.

Low Battery. Plug in the AC power source. If the c
turn it off then on again.

You are losing battery
power too quickly.

The system is using too much power. If your OS
“Power Schemes” on page 4 - 4) check its settin
device that is drawing a lot of power.

Actual battery operating
time is shorter than
expected.

The battery has not been fully discharged before b
is fully discharged and recharge it completely befo
on page 4 - 9).

Power Options have been disabled. Go to the Con
the options.

A peripheral device or PC Card is consuming a lot 
save power.
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9

he vents/fan intakes are not blocked. If
ernate mode or turn it off for an hour.
rface (see “Overheating” on page 1 -

ed off before putting it into a travel bag
 powered on in a travel bag may cause

olution
- 8 Power

The computer feels too
hot.

Make sure the computer is properly ventilated and t
this doesn’t cool it down, put the system into Hib
Make sure the computer isn’t sitting on a thermal su
12). Make sure you’re using the correct adapter. 

Make sure that your notebook is completely power
(or any such container). Putting a notebook which is
the vents/fan intakes to be blocked.

Problem Possible Cause - S
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9

olution

leep/resume key combination, Fn + F3

 screen control key combinations Fn +
 - 2). If you’re connected to an external
u should also check the monitor’s own

he screen display key combination, Fn
oard)” on page 3 - 9). If an external

uch the TouchPad.

red it appropriately from the Control
5 - 8 for instructions on installing the
bile” on page 3 - 6 for instructions on
Display

Problem Possible Cause - S

Nothing appears on
screen.

The system is in a power saving mode. Toggle the s
(see “Sleep Button” on page 4 - 8).
\

The screen controls need to be adjusted. Toggle the
F8/F9 (see “Keyboard Video Controls” on page 3
monitor, make sure it’s plugged in and turned on. Yo
brightness and contrast controls.

The computer is set for a different display. Toggle t
+ F7 (see “Switching/Enabling Displays (Keyb
monitor is connected, turn it on.

The screen saver is activated. Press any key or to

No image appears on the
external monitor I have
plugged in and powered
on.

You haven’t installed the video driver and configu
Panel. See “Video (Win2000/WinXP)” on page
driver, and see “Intel Extreme Graphics 2 for Mo
configuring the video driver.
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olution

rge the battery of the CMOS. Contact

sequences of this could be serious. If
you may lose all of the information on
- 10 Boot Password

Boot Password

Problem Possible Cause - S

You forget the boot
password.

If you forget the password, you may have to discha
your service representative for help.

Password Warning
If you choose to set a boot password, NEVER forget your password. The con
you cannot remember your boot password you must contact your vendor and 
your hard disk.
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9

olution

 control in the Volume Control Panel
ation Fn + F5 and F6 (see “Audio

leaner kit.

 Gently try to remove the disc using the

es. See “DVD Regional Codes” on
Audio & CD Device

Problem Possible Cause - S

The sound cannot be
heard or the volume is
very low.

The volume might be set too low. Check the volume
in the Windows taskbar, or use the key combin
Features” on page 3 - 16) to adjust.

The compact disc cannot
be read.

The compact disc is dirty. Clean it with a CD-ROM c

The compact disc tray
will not open when there
is a disc in the tray.

The compact disc is not correctly placed in the tray.
eject hole (see “Loading Discs” on page 2 - 3).

The DVD regional codes
can no longer be
changed.

The code has been changed the maximum 5 tim
page 2 - 5.
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olution

heck that Padlock mode is not enabled

e any standard USB keyboard. The
 keys unique to the system’s regular
- 12 Keyboard

Keyboard

Problem Possible Cause - S

Unwelcome numbers
appear when typing.

If the LED  is lit, then Num Lock is turned ON. C
(see “LED Indicators” on page 1 - 6).

Other Keyboards
If your keyboard is damaged or you just want to make a change, you can us
system will detect and enable it automatically. However special functions/hot
keyboard may not work.
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9

olution

t. Use the AC adapter, press a key on
mbination, or press the power button if

e Windows Power Options menu and
r Options” on page 4 - 6). Make sure
l panel.
Operation
Problem Possible Cause - S

The system freezes or
the screen goes dark.

The system’s power saving features have timed-ou
the keyboard, or press the sleep (Fn + Esc) key co
no LEDs are lit.

The system never goes
into a power saving
mode.

Power Options features are not enabled. Go to th
enable the features you prefer (see “System Powe
you have enabled Hibernate mode from the contro



Troubleshooting

9
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olution

 see if the modules are on or off (see
cator is off, then press the Quick-Key
uick-Key Buttons” on page 1 - 7).

lled. Make sure you have installed the
ctions for the appropriate module in
- 14 Modules

Modules
Problem Possible Cause - S

The Wireless LAN/
Bluetooth/ PC Camera
modules cannot be
detected.

The modules are off. Check the LED indicators to
“LED Indicators” on page 1 - 6). If the LED indi
combination in order to enable the modules (see “Q

The Wireless LAN/
Bluetooth/ PC Camera
modules cannot be
configured.

The driver(s) for the module(s) have not been insta
driver for the appropriate module (see the instru
“Modules” on page 8 - 1).
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 Jacks)

rts & jacks) which allow your com-
.

Appendix A : Interface (Ports &
Overview
The following chapter will give a quick description of the interface (po
puter to communicate with external devices, connect to the internet etc
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A

r computer 

st digital storage cards. Push the card
e.

r your computer.

 or Flat Panel Display, to get dual video
onitor/FPD (see “Display Devices” on

gh this jack. Note: Set your system’s
 jack.

rough the computer’s speakers.
- 2

Ports and Jacks

Item Description

Built-In Microphone The built-in microphone allows you to record on you

Card Reader Port The card reader allows you to use some of the late
into the slot and it will appear as a removable devic

DC-In Jack Plug the supplied AC adapter into this jack to powe

External Monitor (VGA) 
Port

This port allows you to connect an external monitor,
or simultaneous display on the LCD and external m
page 3 - 9).

Headphone-Out Jack Headphones or speakers may be connected throu
volume to a reduced level before connecting to this

Line-In Jack The Line-In jack allows you to play audio sources th
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A

d on your computer.

s peripheral devices, e.g. external disk

t supports ECP (Extended Capabilities
des.

plug the telephone line directly into this

nect to the LAN port.

nect to the LAN port.

POWERED IEEE 1394 devices.
Microphone-In Jack Plug an external microphone in to this jack to recor

Mini-IEEE 1394a Port This port allows a high-speed connection to variou
drives and digital cameras (see note below).

Parallel Port Connect a parallel type printer to this port. The por
Port) and EPP (Enhanced Parallel Port) 1.7/1.9 mo

RJ-11 Phone Jack This port connects to the built-in modem. You may 
RJ-11 telephone connection. 
Note: Broadband (e.g. ADSL) modems usually con

RJ-45 LAN Jack This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually con

Item Description

IEEE 1394
The Mini-IEEE 1394a ports only support SELF 
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A

n be attached to this slot. Locks can be

) Out Port allows you to connect your
ver for “5.1” or ‘dts’ surround sound.

w DVDs, VCDs or anything else your
le to make the connection. Enable this

USB 1.1 compliant) are for low-speed
nd for high-speed peripherals such as
 scanners etc. Devices can be plugged
er, without the need to turn the system
mA or above, make sure you use the
- 4

Security Lock Slot To prevent possible theft, a Kensington-type lock ca
purchased at any computer store.

S/PDIF-Out Jack This S/PDIF (Sony/Philips Digital Interface Format
DVD-capable PC to a Dolby AC-3 compatible recei

S-Video-Out Jack Connect your television to your computer and vie
computer can display. You will need an S-Video cab
port from the video driver controls.

USB 2.0/1.1 Ports These USB 2.0 compatible ports (USB 2.0 is fully 
peripherals such as keyboards, mice or scanners, a
external HDDs, digital video cameras or high-speed
into the computer, and unplugged from the comput
off (if the power rating of your USB device is 500
power supply which comes with the device).

Item Description
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aving
d how
l CPU
Appendix B: Advanced Power S
This Appendix contains advanced information on Power Schemes an
they affect the computer’s CPU performance, and information on Inte
SpeedStep controls.
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r Performance
djust the processor performance of
is worth bearing in mind if you are
pecially under DC/battery power).
ee sidebar) used with each power

ropriate for the conditions and the
 applications, audio and video pro-
mance). See also Table B - 2 CPU

4 for further information on power

er DC Power

Adaptive

Adaptive

Degrade

None

Adaptive

Degrade
 - 2

Power Schemes and Processo
Each Windows Power Scheme will also a
your machine in order to save power. This 
experiencing any reduced performance (es
Windows defines four control policies (s
scheme. 

Set the Power Scheme which is most app
applications you are using (e.g. games, 3D
grams etc. usually require high CPU perfor
SpeedStep Control Settings’ on page B - 
saving settings and CPU performance.

Power Scheme AC Pow

Home/Office Desk None

Portable/Laptop Adaptive

Presentation Adaptive

Always On None

Minimal Power Management Adaptive

Max Battery Adaptive

Windows Control 
Policies

Constant ~ CPU’s
performance always
runs at lowest level

Adaptive ~ CPU’s per-
formance will be ad-
justed as demanded
by the system

Degrade ~ CPU’s per-
formance starts at low-
est level and reduces
as battery discharges

None ~ CPU’s perfor-
mance always runs at
the highest available
performance state

Table B - 1
Power Scheme 
Control Policies
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B

essor’s
sor the
ions to
edStep
how to
u)” on

ort the
e Win-
itional

hanced

be dis-

CPU Performance 
with SpeedStep 

The CPU SpeedStep op-
tions will adjust the speed
of the CPU according to
the setting in the BIOS,
and in some cases this
will reduce the CPU per-
formance in order to con-
serve power consumption
(generally speaking the
higher the speed a CPU
runs, the more power it
will consume). You will
need to set the CPU
SpeedStep settings (and
the Windows Power
Scheme settings) in or-
der to gain a balance be-
tween good performance
and power saving.

Figure B - 1
Hot Key Display
Intel CPU SpeedStep Controls
Additional controls are available to support the Intel Pentium M proc
mobile power management features. If you have a Celeron M Proces
settings are emulated by CPU throttling and you may still set the opt
your preference. These controls may be adjusted in the Intel CPU Spe
settings in the BIOS. See “BIOS Utilities” on page 6 - 1 for details on 
access the BIOS utilities, and “CPU SpeedStep Controls (Power Men
page 6 - 14 for the specific menu.

Windows XP Service Pack 2
Windows 2000 and Windows XP with Service Pack 1/1a installed supp
basic features of the Intel CPU SpeedStep controls. As long as you hav
dows XP with Service Pack 2 installed, you will automatically get add
processor drivers installed to support added features such as Intel En
SpeedStep Technology and Intel Deeper Alert Sleep State.

Hot Key Display
When the Hot Key driver is installed, the CPU SpeedStep mode will 
played if you plug-in/remove the AC adapter to/from the DC-In Jack)



B

B  Windows (see Table B - 1 on page B - 2).

 Windows XP with Service 
Pack 2

Power 
Source

CPU Speed

AC In
600MHz ~ Max 
Speed*

Battery
Up to Max 
Speed*

AC In 600MHz

Battery Up to 600MHz*

AC In 600MHz ~ Max 
Speed*

Battery Up to 600MHz*
 - 4

* The Speed is defined by the Power Scheme set in

CPU 
SpeedStep 

Control 
Setting

Windows 2000 or Windows
XP with Service Pack 1/1a

Power 
Source

CPU 
Speed

Perfor-
mance Mode 
Always

AC In CPU Max 
Speed

Battery CPU Max 
Speed

Battery 
Optimized 
Always

AC In 600MHz

Battery 600MHz

Automati-
cally Switch

AC In CPU Max 
Speed

Battery 600MHz

CPU SpeedStep 
Control Settings

You can adjust the
SpeedStep control set-
tings from the BIOS
(see “CPU Speed-
Step Controls (Power
Menu)” on page 5 -
15). The default BIOS
setting is Automati-
cally Switch. However
even if the CPU set-
tings are at *Max
Speed/600MHz, the
CPU speed will still be
affected by the Win-
dows Power Scheme
setting (this may also
adjust the CPU
speed).

Table B - 2
CPU SpeedStep 
Control Settings
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s. Certain items (particularly proces-
to the manufacturer's release sched-
Appendix C: Specifications

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to pres
sor types/speeds and CD/DVD device types) may be changed or updated due 
ule. Check with your service center for details.
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 0.13 Micron Process Technology, 1MB 
2 Cache & 400MHz FSB - 1.4/ 1.5/ 
GHz

 0.09 Micron Process Technology, 2MB 
2 Cache & 400MHz FSB - 
/ 735/ 745/ 755/ 765

 0.13 Micron Process Technology, 
n-die L2 Cache & 400MHz FSB - 
/ 340

 0.09 Micron Process Technology, 1MB 
2 Cache & 400MHz FSB - 
/ 370

 Expandable up to 2GB (128/ 256/ 
4 MB DDR Modules)

 BIOS

GA Flat Panel TFT (1400 * 1050)
 - 2

Feature Specification

Processor Types Intel Pentium® M - (478-pin) Micro-FCPGA 
package

(µ0.13)
On-die L
1.6/ 1.7 

Intel Pentium® M - (478-pin) Micro-FCPGA 
package

(µ0.09)
On-die L
715/ 725

Intel Celeron® M - (478-pin) Micro-FCPGA 
package

(µ0.13)
512KB O
320/ 330

Intel Celeron® M - (478-pin) Micro-FCPGA 
package

(µ0.09)
On-die L
350/ 360

Core Logic Intel 855GME + ICH4-M

Security Security (Kensington® Type) Lock Slot 

Memory Two 200-Pin SODIMM Sockets, Supporting 
DDR 266 / DDR 333 MHz Modules Only
(Note: Do Not Use Other Module Types)

Memory
512/ 102

BIOS One 512KB Flash ROM Phoenix

LCD Options 15.0" XGA Flat Panel TFT (1024*768) 15.0" SX
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ectX 7/8 Compliant Graphics Engine
s VESA DDCI, DDC2B and DDC 3.0 
ations

e Drive (see “Optional” on page C - 

lex 
Digital Output
Microphone
n Stereo Speakers

TouchPad with Scrolling Function

adphone-Out Jack
rophone-In Jack
e-In Jack
-11 Jack for Plug & Play Fax/Modem
-45 Jack for 100M (Max) Fast Ethernet
-in Jack
Display Dynamic Video Memory Technology (Shared 
Memory up to 64MB)
128 bit 2D/3D Graphics Engine
Motion Compensation for DVD Accelerator

Fully Dir
Support
Specific

Storage One changeable 12.7mm(h) Optical Device (CD/DVD) Typ
5 for drive options)
Easy changeable 2.5" 9.5 mm (h) IDE HDD

Supports LBA Mode, Master Mode IDE, PIO Mode 4

Audio AC’97 2.2 Compliant
Advanced Wavetable Synthesizer
DirectSound™ 3D Accelerator

Full-Dup
S/PDIF 
Built-In 
2 Built-I

Keyboard & 
Pointing Device

Winkey Keyboard Built-In 

PCMCIA One Type-II PCMCIA 3.3V/5V Socket

Interface Four USB 2.0/1.1 Ports
One Mini-IEEE1394a Port
One External VGA Monitor Port
One Parallel Port (LPT1) Supporting ECP/EPP
One S/PDIF Output Jack
One S-Video-Out Jack

One He
One Mic
One Lin
One RJ
One RJ
One DC

Feature Specification
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th & MDC Modem Combo Module 
y Option)

O/Wireless LAN Module with Mini-PCI 
 (see “WLAN Module Options” on 
- 5 for drive options)

s Battery Low Sleep Mode
s Resume From Modem Ring
s Wake on LAN

ours battery life

 Humidity
erating: 20% ~ 80%
n-Operating: 10% ~ 90%
 - 4

Card Reader Embedded 4-in-1 Card Reader (MS/ MS Pro/ SD/ MMC)

Communication 56K Plug & Play Fax/Modem V.90/92 
Compliant

10/100M Fast Ethernet (IEEE 802.3 and 
802.3u Standard Compliant)

PC Camera with USB Interface
(Factory Option)

Bluetoo
(Factor

Intel PR
Interface
page C 

Power 
Management

Supports ACPI 2.0
Power Button as Sleep/Resume Key
Supports Hibernate Mode
Supports Standby Mode

Support
Support
Support

Power Full Range AC Adapter
AC-Input 100~240V, 47~63Hz
DC Output 65 Watts

One 6 Cell, Smart Lithium-Ion Battery Pack - Approx 4.5 H

Environmental 
Spec

Temperature
Operating:  5°C ~ 35°C
Non-Operating: -20°C ~ 60°C

Relative
Op
No

Feature Specification
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C

ith Battery

th & MDC Modem Combo Module

era with USB Interface

e DVD Player
Physical 
Dimensions & 
Weight

329mm (w) * 275mm (d) * 25mm (h) Min 3.1 kg W

Optional Optical Drive Module Options:
CD-ROM Drive Module 
Combo Drive Module
DVD-ROM Drive Module
DVD-Dual Drive Module

Bluetoo

PC Cam

Softwar

WLAN Module 
Options

Intel PRO/Wireless 2100 (802.11b) Wireless 
LAN Module with Mini-PCI Interface

OR
Intel PRO/Wireless 2200BG (802.11b/g) 
Wireless LAN Module with Mini-PCI Interface

OR
Intel PRO/Wireless 2915ABG (802.11a/b/g) 
Wireless LAN Module with Mini-PCI Interface

Feature Specification
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